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Tiivistelmä 

Tiivistelmä  
Vuosina 1999-2002 Turun yliopiston Amazon tutkimusryhmässä toteutettiin Internet-
pohjainen Länsi-Amazonian paikkatietojärjestelmä, Western Amazonian GIS 
(WAGIS). Järjestelmän perustana on koko tutkimusalueen kattava 
satelliittikuvamosaiikki ja lisänä on toivottavasti kasvava määrä erilaista 
paikkatietoaineistoa.  

Amazonin alue on yksi maailman heikoimmin tunnetuista maa-alueista ekosysteemi-
ensä sekä niiden kehittymisen ja dynamiikan osalta. Myös ihmisen prosesseja, kuten 
maankäytön suunnittelua ja kaavoitusta ajatellen tutkimustietoa ja kartografisia tuot-
teita on heikosti saatavilla. Kaukokartoitus, etenkin satelliittikuvat, tarjoavat kuitenkin 
nykyisin luotettavan aineistolähteen laajoista ja vaikeasti saavutettavista alueista.  

WAGIS -mosaiikkia varten hankittiin kahdesta eri satelliittikuva-arkistosta n. 150 
Landsat TM ja MSS kuvaa vuosilta 1984 - 1996. Näistä koottiin kuvamosaiikki, joka 
valmistuessaan sisälsi 126 kuvaa ja peitti n. 3.5 milj. km2 sadan metrin pikselikoolla. 
Tavoitteena oli luoda mahdollisimman yhtenäinen satelliittikuvapinta Amazon ryh-
män tutkijoiden – biologien , ekologien, geologien ja maantieteilijöiden – käyttöön. 
Kuvapinnan tuottaminen kuvien valinnasta ja tilaamisesta mosaiikkituotteen viimeis-
telyyn sisälsi useita erillisiä työvaiheita ja vaati lukuisia testauksia parhaan työtavan ja 
tuloksen saavuttamiseksi sekä monia keskusteluja tutkimusryhmän jäsenten kanssa.  

Ensimmäinen työvaihe oli eri aineistolähteiden kartoitus. Varsinainen kuvien valinta 
ja tilaaminen perustui Eros Data Center –arkiston sekä Michigan State Universityn 
Tropical Rain Forest Research Instituten Internet-palveluihin. Kuvat tilattiin ns. 
quicklook kuvien ja pilvisyystietojen perusteella. Kuvat saapuivat postitse kevään ja 
kesän 2000 aikana nauhoilla tai CD-ROMeilla. Kuvat importointiin Erdas Imagine –
formaattiin, niiden laatu varmistettiin ja kukin kuva talletettiin omalle CD:lleen ja 
sijoitettiin kuva-arkistoon. Tämän jälkeen kuvat oikaistiin maantieteelliseen pituus-
leveysaste –koordinaatistoon käyttäen referenssipintana GTRF-projektin JERS-1 SAR 
tutkakuvamosaiikkia sekä tarkempia mosaiikkeja Iquitosin ympäristöstä ja Madre de 
Diosin alueelta.  

Mosaikointiprosessi itsessään oli yksinkertainen, mutta eri vuosina ja vuodenaikoina 
otettujen kuvien arvojen sovittaminen yhteen vaati lukuisia testauksia ja kompromis-
seja. Pienten erojen havaitseminen tasaisesta metsäpinnasta vaati voimakkaita venytys 
(stretching) -operaatioita, jotka korostivat ilmakehän aiheuttamia ja sensorien teknisiä 
häiriöitä. Lopputulos on tyydyttävä, vaikka kuvien rajat näkyvätkin vaihtelevasti 
mosaiikin eri osissa.  

Kuvamosaiikki ja joukko muita GIS-aineistoja on käytettävissä WAGIS-
käyttöliittymän kautta Internet-selaimella. ArcIMS-palvelimeen perustuva järjestelmä 
tarjoaa keskeisimmät paikkatiedon käsittelyssä tarvittavat toiminnot, kuten kartan 
näkymän muutokset, tasojen hallinnan, etsinnät, kyselyt ja tiedon haun. Projektin 
yhteydessä toteutettiin myös CD-arkisto ja tietokanta Landsat TM –kuvia ja Amazon-
ryhmän muita aineistoja varten. Tietokannan tietoja voidaan selata ja päivittää 
Internet-käyttöliittymän kautta. Karttapalvelu ja CD-tietokanta ovat löytyvät Amazon-
ryhmän Internet-sivuilta osoitteesta www.utu.fi/ml/amazon. 
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Summary 

Summary 
At present the Amazonian area is poorly known and the amount of scientific 
information about the patterns, processes and history of the area is scanty. There is a 
clear lack of reliable cartographic products. The University of Turku Amazon 
Research Team (UTU-ART) has developed a Western Amazonian GIS (WAGIS) to 
overcome some of these problems and to facilitate the easy access of biologists, 
ecologists, geologists and geographers to relevant data over the area. 

Earth observation and particularly space-borne remote sensing, has made it possible to 
acquire reliable data even from inaccessible and previously poorly known areas. 
Between the years 1999 and 2002 the WAGIS project of UTU-ART collected, 
harmonized and mosaicked a set of c. 120 Landsat TM images over the Western 
Amazonia. The mosaic and other data sets within the information system cover an 
area of 3.5 million km2 extending to areas of Brazil, Bolivia, Colombia, Ecuador, Peru 
and Brazil. The Landsat mosaic, forms the basis of the system by providing a 
continuous map surface extending over the area. Landsat TM and MSS scenes from 
years between 1984 and 1996 were purchased from three large image archives: Eros 
Data Center, Michigan State University TRFIC and Maryland University archives.  

After searching for several image archives, four separate image orders were made 
during spring 2000. After arrival of the imagery CDs and tapes, the different file 
formats were imported to Erdas Imagine format. Each scene was checked and put on 
CD archive. Images were rectified and georeferenced to the Longitude/Latitude 
coordinate system with WGS84 datum. A JERS-1 SAR mosaic created by the GRFM 
project was used as a source of coordinate information. The final mosaic was re-
georefenced using spatially more accurate mosaics from Iquitos and Madre de Dios 
areas. Later, some cloudy images were replaced. 

The final mosaic was published in June 2001 and an improved version in August 
2002. It provides a data set usable for both examinations of the patterns of the entire 
Western Amazonia and smaller more local patterns. The goal in creating a consistent 
image surface was achieved relatively well. In some areas image borders are difficult 
to detect, but in other areas, the differences between image scenes are striking. 
Nevertheless, the mosaic enables us to examine large natural patterns over the area 
and the experience gained in the mosaicking process can be used to later improve the 
final product.  

To access the mosaic and additional data, an Internet map service was set up on the 
server of the Laboratory of Computer Cartography (UTU-LCC). This service has been 
developed using ArcIMS software and it is accessible through the Internet pages of 
the Amazon Research Team (www.utu.fi/ml/amazon). Additionally, the CD storage of 
the Amazon Team can be browsed using an Access database, which is linked to the 
project pages as well. 
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Introduction 

1. Introduction 
Satellite image archives are useful sources for research and monitoring efforts in 
extensive land areas. Sometimes, space-borne Earth Observation (EO) archive data is 
provided for users with low cost, making it possible for even small and medium budget 
projects to acquire several images. Consequently, the existing EO archives act as an 
unparalleled source of material for innovative approaches in basic and applied research.  
Internet-based information systems enable the use of large GIS and remote sensing data 
sets with standard tools independently from geographical location. The novel software 
makes it relatively easy to produce an Internet map service through which users can 
access and analyze shared data sets. If built as open systems, they also provide the 
possibilities for distribution of spatial information among institutes thus bringing together 
the data fragments available from the interest area. 
The University of Turku Amazon Research Team (UTU-ART) has taken the advantage of 
these possibilities and created a mosaic of Landsat TM images over the western Amazon 
and published it in the Internet. Including parts of Colombia, Ecuador, Peru, Bolivia and 
western Brazil, the mosaic covers 3.5 million km2 in area and is expected to support 
scientific basic research carried out in the region by providing comprehensive data that 
extends over the country borders.  
The image mosaicking work was completed during the years 1999-2002 using 126 
Landsat TM images. The steps needed in the image processing and the methodologies to 
be used were compared in the beginning of the project, and the most suitable 
methodologies were then applied in the processing of the imagery. The present document 
summarizes these work phases from image orders to the creation of the Internet service 
for its presentation. Appendices present more technical information of image processing 
and mosaicking, CD filing, and modification of the Internet map service site. 
The work team consisted of researchers and auxiliary assistants of the University of 
Turku Amazon Research Team (UTU-ART). Risto Kalliola has been the leader of the 
process and from June 2000 Tuuli Toivonen haas been the main researcher. Amazon 
Team members Sanna Mäki, Hanna Tuomisto, Kalle Ruokolainen and Matti Räsänen 
have been most involved in the planning and evaluation of the product, where also 
comments and ideas of the other team members have been essential.  
All image analyses were carried out using facilities of the University of Turku Laboratory 
of Computer Cartography (UTU-LCC). Johan Hendriks and Lizardo Fachin participated 
in the first image orders and imports. Albert Driesprong continued with the image 
ordering, importing and building of the archive system as well as writing this document. 
Riikka Koskinen and Johan Hendriks made most of the image rectifications.  
In Peru, collaboration has been made with the Instituto de Investigaciones de la Amazonia 
Peruana (IIAP, Iquitos, Peru) within the framework of the project BIODAMAZ 
(Biological Diversity in Peruvian Amazonia Project). This project is a joint venture of the 
Finnish and Peruvian governments and it has produced a similar mosaic of Landsat TM 
images from the Peruvian Amazon (BIODAMAZ 2002). 
The Peruvian mosaic has been published in the Internet and it forms part of the Peruvian 
Amazonian environmental and biodiversity information system, SIAMAZONIA. 
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Work strategy 

2. Work strategy 
The satellite image mosaic was planned to support scientific research and form an 
integral part of an internet-based map service. Its creation has involved thorough 
planning of the specific demands and criteria for the final product, as defined by the 
scientific team:  

1) The area of the mosaic should cover the lowland Amazonia (< 500 m a.s.l.) 
between 17°S and 7°N and longitudes from 59°W to 80°W.  

2) The mosaic should be usable for regional examination of the Western 
Amazon. Images should be as clear from clouds as possible and scene borders 
should not interfere interpretation. 

3) Cost for the images should be low; all images are purchased from international 
data archives. 

After agreeing on the thematic and technical criteria for the desired image mosaic, the 
following tasks were identified within the process:   

• Search and selection of images from available image sources and their 
purchase 

• Creation of a system for naming of image files and their archiving  
• Importing of the received images into standard file format and pre-checking 

them 
• Geometric and radiometric corrections if needed 
• Creation of and improvement of the image mosaic 
• Putting up the Internet service for viewing the mosaic with other data sets. 

Because of the large number of images to be used, the work phases needed to be well 
tested before the production phase. As several persons were involved in the process, 
special attention was paid to systematic working conventions and reporting. Figure 1 
presents the phases of the project, which are described in detail in the following 
chapters. 

 

Landsat data 
acquisition

Import and 
pre-check Preprocessing Mosaicking

Building the 
Internet map 

service

Creation of the 
CD filing system 

& database

 

Figure 1. Phases of the project from acquisition of data to distributing it via Internet map service.  
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Acquisition of Landsat data 

3. Acquisition of Landsat data 
Records of several satellite image archives can be browsed in the Internet. These 
sources were searched systematically by using some well-known search engines (e.g. 
Yahoo, Google, Altavista) to look for the availability of original satellite images 
covering the Amazon region. Main data archives found to fulfill these criteria were 
Michigan State University’s TRFIC, Nasa’s EDC-DAAC and University of Maryland 
GLCF (Table 1). 

Table 1. Properties of the Internet-based services, which were used to access satellite image archives 
of the western Amazon region. 

 EROS DATA CENTER MICHIGAN STATE 
UNIVERSITY 

UNIVERSITY OF 
MARYLAND 

Description NASA data archives Michigan State 
University, tropical rain 
forest research institute 
Landsat archives. 

University of Maryland, 
Global Land Cover 
Facility. 

Acronym EDC-DAAC TRFIC UMD GLCF 
Internet 
address 

http://edcimswww.cr.usgs.go
v/pub/imswelcome/plain.html 

http://www.bsrsi.msu.edu/
trfic/ 

http://glcf.umiacs.umd.
edu/ 

Available 
imagery 

Several image types,  
Landsat TM & MSS 

Landsat TM Landsat, Terra-Modis, 
NOAA Avhrr & several 
landcover products  

Spatial 
coverage 

Disassembled over the globe Amazon basin, Kongo 
basin, South East Asia & 
U.S.A 

North and South America, 
Africa  

Temporal 
coverage 

1984 -  - - 

Restrictions Only images older than 10 
years are available 

No restrictions No restrictions 

Price 15 USD  25 USD Free 
Format 3 formats, NLAPS, MEDIPS, 

FAST 
Erdas Imagine IMG BSQ 

Media 8mm high density tape CD-ROM Download in zip-files 
Contact person Michael Struck  

struck@edcmail.cr.usgs.gov 
Jay Samek 
samekjay@pilot.msu.edu 

 

Browsing of the Internet sites of different data producers showed that obtaining 
satellite images is easiest by browsing the on-line catalogues on the Internet. In most 
cases these browsers provide both quicklooks and metadata of the available scenes. 
Appendix A presents an example of the metadata attached to each image. Orders can 
often be placed on-line. Prices of the images vary a lot and range from free to about 
US$ 25,00 a piece, and up to a couple of thousands US$ a piece.   

The main objective of this assignment was to order an image set, with high quality 
and low cost, covering the western half of the Amazon region. In order to find the best 
images the catalogues of EDC-DAAC and the TRFIC were searched systematically, 
according to single path-row combinations. For each location the metadata provided 
in the website and the quicklooks of the available images were compared with each 
other. Selection was made based on the amount of cloud cover, and the presence of 
haze, smoke and possible missing values (present in some archive imagery). 
Furthermore, attention in the selection was paid to the distribution restrictions and 
processing levels.  
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Acquisition of Landsat data 

Only systematically corrected images were considered useful, since they do not 
restrict the user in any way. After selecting the most appropriate scenes, an order 
proposal containing price information and metadata was made. Before making the 
final decisions, the order proposals were discussed with members of the Amazon 
Research Team. After the first set of purchased images had arrived, new orders were 
made to replace cloudy or otherwise poor quality images. The last orders from TRFIC 
and downloads from University of Maryland were made during spring 2002. Table 2 
presents the images ordered from different archives.  

Table 2. Image orders from the EDC-DAAC and TRFIC archives. 

Place Number of img Order month Arrival Other 
EDC-DAAC 36 TM & 7 MSS March 2000 April 2000 Peruvian Amazon 

TRFIC 12 TM May 2000 June 2000 Replacement 

TRFIC 38 TM May 2000 June 2000 Other regions 

EDC-DAAC 45 TM May 2000 July 2000 Other regions & replacement 

TRFIC 16TM Dec 2001 Jan 2002 Replacement 

UMD GLCF c. 10 April 2002 April 2002 Replacement 

 
The images that were selected for the mosaic were acquired during 13 years in 
between 1984 and 1997 (Figure 2). Due to the ordering restrictions of the EDC-
DAAC archive, most of the images, 72 in total, were from the 1980’s. Images ordered 
from TRFIC and downloaded from University of Maryland were newer. The long 
time span of the acquisition of the imagery caused variation in the sensor properties 
and in the landscape in the form of advancing human constructions and river 
movement. Additionally, phenological states of vegetation were sometimes somewhat 
different in adjacent images. Different acquisition months caused also differences in 
sun azimuths and sun elevation. Furthermore, the changes in vegetation and at places 
river channels caused discontinuities at image borders.  

  

Figure 2. Acquisition year and month of the scenes in the mosaic. The maps give the general impression of the 
situation, but some of the scenes may later have been replaced with newer or better images. 
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Import and pre-check 

4. Import and pre-check 
Landsat satellite images were received in different formats and specific procedures 
were required for their import into a standard file format (Erdas Imagine): 

• EDC-DAAC archives provided images on 8 mm high density tapes, in three different 
formats: EOSAT Fast Format, NLAPS and MEDIPS (MSS image format). The tapes 
were imported using Erdas Imagine in UNIX system. The time needed for importing an 
image varied between 1.5 and 2 hours, depending on the amount of bands, rows and 
columns the image contained. For each format the data import procedure was slightly 
different (see Appendix D and Erdas Imagine manuals for more information). In case the 
quality was intolerable the import process was carried out again, which in some cases 
resulted in a better image. 

• Data obtained from the TRFIC-Archive was received on CDs in Erdas Imagine format 
and did not, therefore, require any special processing. 

• University of Maryland GLCF images can be downloaded in zipped BSQ-format. The 
download is made band by band. Additionally, a metadata file is needed for information 
on number of rows and columns in each image. Download time was approximately 7 
minutes per band. Files were unzipped and imported to Erdas Imagine. 

After import each image was checked layer by layer. Image quality, namely 
cloudiness, striping, banding and missing values, was evaluated on the computer 
screen. This evaluation was used to define the usability of each obtained image. Each 
image was stored to a separate CD ROM together with related metadata. In order to 
keep track on the CDs and their metadata, a CD filing system and database for 
handling the image data was created. Finally a duplicate of each CD was made for 
sharing the data with the Peruvian Amazon Research Institute (IIAP).  

10 



CD filing system and access database 

5. CD filing system and access database 
Each Landsat TM image obtained from the data producers or modified during the 
mosaic work was stored to individual CD ROM. Each CD was numbered with a 
running number and placed to UTU-ART archive folder in LCC. Each folder contains 
50 CDs, which are all stored together with an information sheet, providing a 
quicklook and some basic metadata (for example of metadata, see Appendix A). 

In order to maintain this archive and to create a possibility to search for specific data, 
a relational database was constructed with Microsoft Access. The structure of this 
database has been designed in such a way that many types of data can be included, 
varying from e.g. text files and multimedia to GIS and Remote Sensing Information. 
This is of specific importance since in future the UTU-ART archive is expected to 
contain a large variety of data sets. However, at this stage the core of the database 
consists of Remote Sensing data related to the purchased Landsat images. Thus, this 
part of the database is described in this document. A simplified table structure of the 
database is presented in Figure 3. The database consists of the following three main 
tables. Their structure is described in more detail in Appendix C, page 45. 

• FILES table is used to store basic information about all records entered to the 
database regardless of their type. For example, the CD number, file name and file 
type. 

• LANDSAT_ORIGINAL table stores the basic information about all purchased 
images. For example sensor, path, row and acquisition date. This table is linked 
to the FILES table on a one-to-one basis.  

• PROCESSED_IMAGES table is used for any type of processed Remote Sensing 
images. This table stores details about the applied processing types and provides 
the CD-number of the original image. A connection to the FILES table exists, 
based on a one-to-one basis. 

Next to the three main tables, there are 9 smaller tables, which are used to store the 
options of available pull down lists. Further, two information files were created for 
each original Landsat image. The first is a metadata file in text format, containing all 
available information about the image, and the second is a quicklook picture in JPEG 
format. Hyperlinks connect both files to the database. The metadata is normally 
provided by the image producers, while the quicklooks were created by taking a 
screen capture of each image. 

 
Figure 3. A simplified table structure of the WAGIS images CD database.  
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CD filing system and access database 

Data entry is possible through the intranet by using Data Access Pages, which can be 
opened in the Internet Explorer browser (version 5 or higher). For each type of data 
there is a different page to fill. In order to keep the entering of data as simple as 
possible, selection lists are provided whenever appropriate. Additional information is 
given by the different links clickable on each of the pages. They will either open a 
new page containing information, or just a short alert message. Figure 4 shows the 
page used for entering data on original Landsat images to the database. 

 
Figure 4. Page for adding original Landsat images to the database.  

Searching for data in the database is based on a two-step approach. For each data type 
there’s a page that lists some key variables per record (Figure 5). The user is able to 
adjust the order of the list in various ways by clicking the titles of the key variables. 
Doing so, it is rather easy to find a certain record. Once found, a complete data page 
for that one record can be accessed from the more info link. Figure 6 gives an example 
of such a page. 
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CD filing system and access database 

 
Figure 5. List of key variables for original Landsat images.  

 

 
Figure 6. Example of a data page, which provides data on a particular original Landsat image. Note 
also the metadata link, which will open the metadata file mentioned above. 

More detailed information on the technical solutions related to the database entry and 
search pages can be found from Appendix D starting from page 47. 
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Image preprocessing 

6. Image preprocessing  
Preprocessing of the imagery after import consisted of a few successive steps from 
rectification and cleaning to matching of the images. Before the preprocessing started, 
several tests were made to find out the most beneficial ways to proceed. Pre-tests were 
made with small sets of images to compare different processing software, rectification 
methods, make comparisons between sources of coordinate information and possible 
atmospheric correction methods. Figure 4 presents the processing steps from import to 
the actual mosaicking. Technical instructions of all the steps can be found from 
Appendix B, starting from page 30. 

Figure 4. Processing steps between import and finalizing the mosaic product. Rectangles indicate 
actual processing steps and oblique polygons the main tests made. Diskettes show the steps where the 
information was systematically stored on CD. 

Georeferencing and rectification 

The goal was to georeference the images with as consistent and high spatial accuracy 
as possible. In order to present the entire western Amazonia in one coordinate system 
and to ensure the usability of the mosaic together with most GIS data, the 
geographical coordinate system Longitude/Latitude was selected. The world geodetic 
system 1984 (WGS84) was used as datum and ellipsoid. A Cartesian coordinate 
system, like UTM, was also considered due to its ability to present locations using 
meters. UTM system uses, however, 6° wide zones. Thus, several different zones 
would have been needed to cover the entire area. 
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Image preprocessing 

Sources of ground coordinates 

Two approaches were possible in acquiring the ground coordinate information: 1) 
rectification of all images first together with their overlapping areas (see e.g. 
Rosenqvist et al. 2000) and then to Earth coordinates 2) rectification of each scene 
straight to Earth coordinates. The first option would have ensured the continuity of 
features from scene to another, on the expense of spatial accuracy. Thus, the second 
option was selected to prevent distortion of the mosaic. Individual registration of 126 
scenes required, however, a good source of coordinate data. Different sources of Earth 
coordinates were evaluated and tested.  

Table 3 shows a comparison of the most interesting options for collecting coordinate 
information. Paper maps were considered too inconsistent source of information. 
Metadata related to scenes occasionally contained image corner coordinates, but they 
were provided in different coordinate systems, datums and ellipsoids. Not all the 
images had this information. Furthermore, tests showed that this information was 
fairly unreliable. The third option is to apply a ready-made mosaic such as the one 
created by the GRFM project of JERS-1 SAR images with 100 meter pixel size over 
the entire basin of Amazonia (Rosenqvist et al. 2000). 

Table 3. Results of the evaluation of ground control points (GCPs) from different sources. 

GCP source Evaluation 

Coordinates from paper maps + accurate 
– slow and laborious 
– good maps are not available for the entire area 

Coordinates provided in metadata + easy to acquire 
– not available in all images 
– several coordinate systems used  
– unreliable testing required for individual images 
– discontinuous objects at image borders 

JESR-1 SAR mosaic from GRFM 
project 

+ Continuous and consistent surface 
+ Control points relatively easy to locate 
+ Digital format 
– Locational errors are repeated 

Despite the fact that already existing and at places quite severe locational errors were 
repeated, the ease of use of digital imagery and the consistency of the surface justified 
the use of the GRFM mosaic as our reference. All images were georeferenced using 
six ground control points (GCPs). After selecting the GCPs, their image and earth 
coordinates were saved to separate files. In most cases, the control points were 
selected only from the JERS mosaic. Some mountainous images needed, however, 
also ground control points from adjacent images to fit to the mosaic. Centers of 
oxbow lakes and other relatively stable points were selected and if such were not 
available, also river meanders having distinctive shapes were used.  

Rectification 

Each image was rectified and resampled according to the GCPs. Table 4. presents the 
methods used in rectification of the imagery. First order polynomial transformation 
was considered good enough as Landsat images cover only a relatively small area of 
the globe. Some tests made on imagery showed that nearest neighbor method was 
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Image preprocessing 

adequate for resampling the imagery during rectification. With bilinear and cubic 
convolution resampling narrow linear objects retained better, but in general the 
significance of this was small. The fact that nearest neighbor resampling only required 
half of the processing time requires by bilinear and cubic convolution resampling 
methods was considered more important.  

Table 4. Methods and options used in rectification of the imagery. 

METHOD OPTION 

GCP source JERS-1 SAR mosaic from GRFM project 

RMS error  Errors less than 1 pixel were tolerated. 

Transformation First order polynomial 

Resampling method Nearest neighbour 

Pixel size 100 meters 

In order to keep the mosaic file size reasonable, the pixel size of the imagery was set 
to 100 meters instead of the original 30 m or so. This dropped file size for each scene 
from c. 400 MB to c. 30 MB. Due to larger pixels size some details of the landscape 
such as small rivers and lakes, and patterns formed by the convex-concave topography 
were lost. On the other hand, this pixel size is justified due to the relatively rough 
rectification of the images using the GRFM data as described above. Figure 5 presents 
an example landscape with 30-meter and 100-meter pixels sizes. 

 
3 km 

Figure 5. The same landscape with original 30-meter pixel size (left) and new, 100-meter pixel size 
(right).  

Cleaning of the images 

Many images contained white edges and possibly some marks on the corners. After 
rectification, the actual image area was delineated and needless edge areas were cut 
away. At the same step, the thermal band 6 was dropped out of all images. To ensure 
the possibility to trace the original image from the mosaic of images, an info “band” 
was added as the 7th layer of each image. This was simply a layer where all the pixel 
values had the same number as the original image, thus ranging from 1 to 138. 
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Original CD number is in our system unambiguous and it can be linked to 
comprehensive information of the image’s source (e.g. path/row/year). 

Quality of purchased images 

Standard problems of striping, banding, line drops, bit errors etc. are discussed in 
many scientific articles (e.g. Crippen 1989) and remote sensing textbooks (e.g. Mather 
1987, Lillesand & Kiefer 1994). Despite the long discussion and available end user 
software algorithms and filters to correct these defects (e.g. destripe, noise removal 
functions in Erdas Imagine, ER Mapper or PCI) in many cases the problem is difficult 
so solve without removing some significant variation of the pixel values. Striping and 
banding caused by variations in response of individual sensors are present particularly 
in old Landsat MSS scenes, but they can be disturbing occasionally also in TM bands 
2 and 3. The tests made with our imagery showed that the ready-made corrections 
available in the commercial software packages were too arbitrary and caused artificial 
features like river or road shifts to the imagery. Therefore, these corrections were not 
systematically performed. 

Atmospheric effects 

The atmospheric effects, namely scattering, path radiance, haze and clouds, are the 
most serious factor affecting the image quality of sensors operating in the optical 
spectrum. Among others, Tanre et al. (1987), Vermote et al. (1997) and Richter 
(2000) have dealt with the problem and developed tools for atmospheric correction 
and haze removal. To correct our imagery, an extension to Erdas Imagine called 
ATCOR was tested. The software operated with earth-sun distance, atmospheric 
model coefficients, sensor calibration coefficients and with estimation of visibility. It 
was, however, noticed that too many assumptions had to be made and if parameters 
were falsely selected, loss of relevant data would occur. Therefore, finally no 
atmospheric correction algorithm was applied to images. 

Moreover, the atmospheric correction methods did not seem to affect the most severe 
image-matching problem we faced. In most images the one edge was clearly lighter 
than the other one (Figure 6). The direction of this gradient varied from scene to scene 
but it was recognizable in almost all images. The gradient was most severe on band 1 
and it lessened to almost invisible on band 4. TM bands 5 and 7 again suffered from 
the gradient. 
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0.45 – 0.52 µm 0.52-0.60 µm 0.63-0.69 µm 

0.76-0.90 µm 2.08-2.35 µm 1.55-1.75 µm 

Figure 6. Directed gradient in Landsat bands 1,2,3,4,5 and 7 in scene acquired 30th August1993 in 5°S 
70°W. 

Removing the gradient 

The gradient was removed from those images that clearly suffered from it. The 
correction was based on a calculation of a reverse trend surface to even out the 
phenomenon. ArcInfo software was used for the trend surface calculation and 
correction of the images. First, areas with seemingly similar forest were delineated as 
areas of interest in Erdas Imagine and these were exported as ArcInfo grids each 
containing one band of the Landsat image. In ArcInfo, the grid was transformed to set 
of points and a trend surface was calculated for the area using the point values (DNs 
of the original image). The trend was reversed and imported to Erdas imagine. There, 
the reversed trend surface was added to the original image values. The results of this 
process turned out to be quite satisfactory in most cases. 

In the Peruvian image mosaic, the gradient was corrected following the same basic 
idea. However, the trend surface was created using the interpolation option of the 
Erdas Imagine software on the basis of 60-100 selected points covering the same type 
of surfaces across the entire image. This method, which is described thoroughly in 
BIODAMAZ 2002, will most likely be used if mosaic is improved with new images 
in the future.  

18 



Mosaicking 

7. Mosaicking  
The preprocessed images were mosaicked to form a comprehensive coverage over the 
study area. Images had very different DN ranges and the pixel values had to be 
matched before the mosaicking. There were several sets of adjacent images that had 
been acquired during the same day and the matching was started from simple 
unification of all these sets of images. Thereafter, images and image sets acquired in 
different days were adjusted to each other individually. 

Clear (not cloudy) areas were delineated from overlapping areas of images and mean 
DN values for each band was calculated. A correction coefficient was calculated for 
the image to be corrected and all of its values were multiplied with the coefficient. 
This method produced several matched image clusters, which were first mosaicked 
together and then matched to their neighbors using the same method.  

As the images overlapped each other on the scene borders, it was possible to try to 
organize them so that cloudy areas would be under the adjacent scene. No image 
matching or edge feathering was performed anymore at this stage. 

Geographical re-adjustment of the entire mosaic 

When the mosaic was finalized it was noticed that there were errors in the spatial 
accuracy of the mosaic. These originated from the errors present in the JERS mosaic, 
which was used as a reference. The use of this mosaic ensured, however, a good 
consistency of the mosaic (i.e. the images fit relatively well to each other). The 
problem was solved using approximately 40 control points from regions of Iquitos 
and from Madre de Dios and rectifying the image according to these points. The 
control points are shown in Figure 7. The same transformation and resampling 
methods as earlier were applied.  

The quality of the final georeferencing was estimated using field point data from 
Brazil and map data (1:250 000) from Bolivia near Río Beni and Colombia. In all 
cases, errors were less than one kilometer and approximately 100 meters in most cases 
(see Figure 7). The true accuracy was however, difficult to measure owing to the 
uncertainty of the actual location on the GPS points on the map. 
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Figure 7. The mosaic was re-adjusted using geographically accurate mosaics from Madre de Dios and 
Iquitos region (large black squares). These mosaics were created for other purposes of the team with 
accurate ground data. The rectification accuracy was evaluated using GPS measurements from the 
ground. The two example areas presented with greater detail show the location of GPS points 
measured at the river and along the road. These measurements suggest a relatively good spatial 
accuracy for the mosaic (error c. 1 pixel = 100m). The missing images in the SW have later been 
added. 

The final mosaic product 

The first version of the mosaic was published in the August 2002 (Figure 8). It is 
available in one Erdas Imagine file and reserves approximately 3.5 GB of disk space. 
Additionally, it is available in the WAGIS map service in the UTU-ART web pages as 
image file with band combination 5,4,2. The first version of the mosaic is still an 
evolving product – some cloudy images cloud be replaced, and a more advanced 
method used for the removal of the gradient and harmonization of the images.  
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Figure 8. The first version of the mosaic was published in August 2002 in the UTU-
ART Internet pages as a part of the Western Amazonian GIS (WAGIS).  

Table 5 presents the properties of the Landsat TM mosaic, which is accompanied with 
a vector layer containing metadata on each scene within the mosaic. Attributes of this 
layer provide the path, row, acquisition date, sun angles and other information for 
each scene. Additionally, as each image is stored individually to CDs during its 
processing steps, also this information can be found from the attribute table.  

Table 5. Properties of the Landsat TM mosaic over the Western Amazonia. 

Topic Specification 
Aerial coverage Lowland Amazonia (< 500 m a.s.l.) between 17°S and 7°N and 

longitudes from 59°W to 80°W. The total area is c. 3.5 million km². 
Data Landsat TM, Bands 1 to 5 and 7. Thermal infrared band (TM6) excluded. 
Pixel size  100 m 
Coordinate system Longitude/Latitude coordinates with WGS-84 datum. 
Time of image 
acquisition 

Late 1980s or newer; images acquired in different years/seasons can be 
tolerated. 

Data quality Some clouds and haze is present in the images. The borders of the 
scenes are visible in many places. 

Rectification Using JERS SAR-1 mosaic and 6 GCPs per scene 

Spatial accuracy Approximately < 500 meters 
Resampling method Nearest neighbor 
Media Internet mapserver, Erdas Imagine file 
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8. Building the Internet map service  
An Internet-based map service was established to deliver the mosaic and additional 
data layers to the users as easy as possible. Evaluation version the service is usable in 
the intranet of UTU and it provides basic GIS tools such as zooming, panning, 
measuring distances on a map and querying the attribute tables of GIS layers. 

The service is based on mapping engine called ArcIMS 3.1 provided by ESRI, which 
is a software package containing a spatial server for publishing GIS data in the 
Internet and a set of wizards for creating map sites. The following presents phases and 
principles applied in the creation of the map service, and it mostly reflects the 
situation of August 2002. 

Structure of the map service 

A simplified representation of the structure of the service is given in Figure 9. 
Basically there are two important parts, the server side and the client side. The server 
side consists of several components of which the web server and the ArcIMS 
application server are most important. Both servers are able to communicate through a 
servlet, cold fusion or other type of connector. The information the client requests are 
sent through the web server to the ArcIMS application server. There the request is 
processed and the resulting information is passed back to the client, again through the 
web server. A more detailed description of the structure of ArcIMS can be found on 
the ESRI Internet pages 

 
Figure 9. The architecture of the Internet servers for ArcIMS and Internet map server. 

Building the map service 

The map service creation included two subsequent phases. First, ArcIMS wizards 
were used to create the mapservice and the first draft of the website. Secondly, the 
HTML pages, an XML file and a few Javascript files created by the wizard were 
modified manually to improve the interface and functionality of the service. 
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ArcIMS author was first used to select the data sets to be displayed in the service 
and to create the related AXL file. The most important layers that were added to the 
preliminary map service are: 

• Four image layers containing the Landsat TM mosaic (see below) 
• A GIS layer containing rivers 
• A GIS layer containing cities 
• A GIS layer containing roads 
• A GIS layer containing administrative borders 

In future many more data layers will probably be added. For purposes of the 
researchers, addition of digital elevation models, climatological data, field plot 
locations, geological interpretations, vegetation and soil maps and layers describing 
human activities would be valuable. 

The Landsat TM mosaic was added multiple times in separate layers. The pixel sizes 
vary per layer and are 1000 m, 500 m, 250 m and 100 m respectively. When creating 
the map service these different layers were assigned to different zoom levels, so that 
when scale factors are high large pixels are shown and when zooming in, smaller 
pixels. Applying this technique has two advantages:  

• When zooming to higher scale factors ArcIMS uses a smaller image file to process 
the request, which saves time. 

• When zooming to higher scale factors the larger pixel sizes result is less speckled 
images. 

Once the data sets were selected and their properties were set, a mapservice was set 
up in the spatial server using ArcIMS Administrator. Thereafter, the ArcIMS 
designer wizard was used to create HTML pages and the Java scripts and XMLs for 
the website. The site was modified by editing these script files. The most important 
changes were related to: 

• Frame sizes. 
• Background colors. 
• The toolbar position. 
• The toolbar contents 
• The size of the overview map in the top left. 
• The presentation of search results. Now it uses pop op windows. 
• The scale bar. It has different colors and rounds values now. 
• The Layers frame layout. A folder system is included. 
• The names of the layers. Now they are hyperlinks to metadata files 

A more detailed description of the exact changes that were made to the scripts is 
presented in Appendix E, starting from page 53. A screen capture of the resulting 
service is presented in Figure 10. 
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Figure 10. A preliminary version of the WAGIS map service by UTU-ART. 

Using the map service 

The foreseen application value of the map service is that it will provide easy access to 
the image mosaic, covering the entire Western Amazonia, to a wide range us users. 
Accompanied with general cartographic information such as names, political borders 
and road network, the use of this facility should be rather easy even for those who are 
not fully acquainted to utilize enhanced satellite images as base maps. Moreover, as 
new thematic data layers will be implemented into the system, such as those on 
climate, geology, or field study sites, comparisons among different spatial data 
contents is simple and any of them can be related to the image mosaic itself, which is, 
finally, the only available spatial information that shows genuine data colleted across 
the entire region, not just from selected example areas with interpolated or interpreted 
values in between. In order to enable efficient exploratory work along these lines, the 
user interface of the system will be developed further within the limits provided future 
resources, both financial and human capacity. 

When using the map service different layers can be switched on and off. Furthermore, 
each GIS layer can be made active after which it is possible to query the attribute 
table belonging to that layer. Hyperlinks in the layers frame open up web pages that 
provide extra information about the layer. Most of the functionality in the map server 
is however provided by the different tools in the tool bar. The tools available in the 
current version of the UTU-ART service are further explained in Table 6. 
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Table 6. Tools available in the WAGIS map service in August 2002. 

Icon Tool Name Tool Function 

 Legend/Layer 
Toggles between legend and layer. These are shown to the right of your map. 
Legend shows what map colors and symbols mean. Layer lists available data 
themes, called "layers," for the map service you are viewing.  

 Overview Map The overview is a thumbnail window of the overall map view. The overview 
button toggles the window on or off.  

 Zoom In Zoom in is used two ways: click the map or draw a rectangle to define your 
new view. 

 Zoom out Zoom out is used two ways: click the map or draw a rectangle to define your 
new view. 

 Pan Click, hold, and drag to move the map with your mouse. 

 Identify Click a feature to see a list of its attributes in a table. 

 Query Builder Query the database of attributes for map features. 

 Find This searches the database to locate and list features of the active layer.  

 Measure 
Select this tool, then click, drag, and click on the map to measure the distance 
between two points on the map. The distance is displayed using the units you 
specify. 

 
Select by 
rectangle 

Click this button, then draw a rectangle (click and drag diagonally) on the map 
to make selections. 

 Clear Selection Deselect, similar to "Undo" 

 Print 
Click print to open your map view to a new browser window. The window 
includes a title that you specify, and a legend. Click File/Save or File/Print in 
your browser menu. 
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9. Discussion 
We consider that the resulted Landsat TM image mosaic is satisfactory for broad-
scale studies in the Western Amazon region. It is able to express extensive habitats 
and vegetation patterns in the region and it also allows effective zooming that can 
reach the scale of 1:250 000, approximately. As such, the mosaic is the first product to 
our knowledge where large and medium-scale environmental heterogeneity across the 
entire sub-Andean belt of the Amazon can effectively be studied. 

However, the August 2002 version of the mosaic still includes quality restrictions that 
need to be conquered. Differences in the brightness values among the individual 
images still remain, and also the internal illumination gradient residue in some of the 
images to a degree that causes disturbing artifacts in the mosaic. The methodology for 
correcting this problem should be further developed based on the actual causes of the 
phenomenon. Along with problems caused by clouds and haze, these problems restrict 
stretching operations and thus also the interpretation of delicate reflectance patterns in 
the forest canopy. Further, the geographic precision of the mosaic, as it is based on a 
secondary source, may be unsatisfactory at places. This may possess obstacles for 
such uses as on screen digitizing of interpreted vector layers or comparing precise 
GPS-based locations with reflectance patterns shown in the mosaic. Also the 100 
meters pixel size hinders the utility of this mosaic in very local studies.  

The University of Turku does not currently possess resources for continued update of 
the mosaic. The detailed documentation of its making in the present report will 
hopefully facilitate its later improvement if resources for such purpose will become 
available. Also the easy user interface of the image metadata archive was designed to 
support the same purpose, particularly if authors of the first version of the mosaic will 
not be available to participate its future update.  

Basic Internet browser technology was chosen to be the main platform for viewing the 
mosaic because it does not require any special software installed in the client 
computer. It also allows sharing of this information regardless of place and time.  

The user right policy of the mosaic has not been entirely settled at the time of writing 
of this report. After transitional period free viewing will probably be made available 
for anyone interested. Those who intend to use the mosaic at large extent for scientific 
research are expected to seek ways for collaboration with its creators in form of for 
example shared authorship in selected publications. 
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Appendix A) Metadata example 
The following presents one structure of metadata file related to each image scene. 
Also other formats are present owing to the differences in the practices of the image 
providers. 

UTU-ART 011 
 
Sensor: Landsat TM 
ID: HT5007068009002410002624 
A.D.: 1990/01/24 
restrictions = No restrictions 
project_source = Humid Tropical Forest Project TM 
old_scene_id = Y5215514330X0 
path_nbr =   7 
row_nbr =  68 
product_size = FULL_SCENE 
wrs_type = 2 
cloud_cover = 10% but less than 20% 
edc_processing_level = Systematically corrected (See Guide) 
map_projection = Universal Transverse Mercator 
sun_azimuth = 107 
sun_elevation = 51 
resampling_tech = cubic convolution 
data_format = TTRANSFER 
data_file_interleaving = band sequential 
user_orientation = satellite heading 
horizontal_datum = WGS84 
spectral_bands_avail =  1234567 
orientation_angle =    8.029948 
pixel_width =  28.5000 
pixel_height =  28.5000 
radiometric_enhancement = No 
radiometric_calibration = NASA algorithm 
map_zone =     -18 
ellipsoid_semi_major_axis = 6378137.000 
ellipsoid_semi_minor_axis = 6356752.314 
upper_left_lat = -10.62081 
upper_left_lon =  -77.12510 
upper_right_lat = -10.87843 
upper_right_lon =  -75.33021 
lower_right_lat = -12.51748 
lower_right_lon =  -75.56754 
lower_left_lat = -12.25725 
lower_left_lon =  -77.37233 
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Appendix B) Working instructions 

Viewing, selecting and ordering archive images 
Images for WA-GIS mosaic where ordered from two sources: EROS Data Center 
(EDC) and Michigan State University TRFIC archives. Both orders were made using 
Internet pages. The following describes how to use the pages of these two archives. 

EDC archive Internet pages 

Address: http://edcimswww.cr.usgs.gov/pub/imswelcome/plain.html 

1. Enter as a ‘guest’ or sign up as a registered user. 

 

2. Set the ’Select search type’ option to data search and order 
NOTE: if you want to find an image of which you know it’s original ID, select 
Data Granule ID in ’select search type’ and go directly to the bottom and 
’SEARCH’.  

3. Set geographic region to the desired path/row – range (or select graphical by a 
box) by clicking edit at the geographic region option. 

4. Set ’Data set’ option to NASA Landsat Collection. This is necessary to find 
images that are 15 USD each. 
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5. Set the ’time range’ option from the desired start time of which you want to 
purchase images until a current month ten years ago. Less than ten years old 
images are more expensive. 

6. Start the search. 

7. Found data granules will be listed and you can view them in preview window or in 
metadata window. 

Michigan State University archive pages 

Address: http://bsrsi.msu.edu/trfic/ 

1. Select ‘Data Port’ / ’Data Archive’ and choose option 1, GIS-Interface 
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2. Create your own folder by entering E-mail Address and Password.  

3. Log in and select your preferences.  

4. After submitting the login information a map will be build and the available images coinciding 
your preferences are shown.  

5. By double clicking a scene ID you can see a picture of an image and add it to your order if you 
like. 

6. Image orders can be made trough the browser, but it is also possible to copy the image metadata (at 
least path, row and date) in a text document and send it by e-mail to: orders@bsrsi.msu.edu. 
Answers are normally rather quick (within two days). 

Importing the EDC images 
The images from the EDC archives arrived in 8mm tape in three different formats:  
     1) EOSAT Fast Format,  
     2) NLDAPS format (National Landsat Archive Production System) and  
     3) in MEDIPS format (MSS images).  

An import process was required to view these images in Erdas Imagine software. All 
formats had slightly different import procedures. In order to successfully import the 
imagery, at least the following things need to be known: 

• Data format 
• Image size, columns and rows 
• Number of bands 

We used a UNIX station and Erdas Imagine 8.3 to import the images. The following 
lists the import phases with all three different data formats. 

32 

mailto:orders@bsrsi.msu.edu


Appendix B) Working instructions 

Importing FAST format  

The following gives step-by-step instructions for importing images provided in FAST 
format.  

1. Put the right tape in the tape drive 

2. Start Erdas Imagine by typing Imagine in the UNIX terminal window. 

3. Click the button IMPORT on the Erdas Imagine taskbar. 

 

4. Select TM Landsat EOSAT Fast Format in the ’Type’ list of the Import dialog. 

5. Select the option tape in the ’Media’ list of the Import dialog. 
Select the tape drive as the ‘Input device’. At LCC, the name is /dev/rmt/0mb. 
If this option is not available in the list, the drive needs to be added:  
- Select Session > Configuration in the Imagine main task bar.  
- In ’configuration class’, select the option ’tape’. 
- To the ’tape drive device file’ box, type /dev/rmt/0mb (at LCC) or the right file 

name. 
- Return to the Import dialog.  

6. Give a file name in the ’Output file’ edit box and click OK. 
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7. The next dialog will prompt you for further information. The opening of the 
dialog might, however, take a while.  

8. Click ’OK’. The import is starting. This may take a up to two hours. You don’t 
have to specify any other things like interleaving, rows and columns because the 
computer reads it automatically from the FAST format header. The program is 
reading first all bands (fig. 4 = 7) and then it is calculating statistics, pyramid 
layers and closing all layers.  

Importing MEDIPS format 

MEDIPS format is used on Landsat MSS images. The import process is very similar 
to the import of FAST format imagery. The following gives the instructions to import 
data in MEDIPS format. 

1. Put the right tape in the tape drive 

2. Start Erdas Imagine by typing Imagine in the UNIX terminal window. 

3. Click the button IMPORT on the Erdas Imagine taskbar. 

4. Select MSS Landsat in the ’Type’ list of the Import dialog. 

5. Select the option tape in the ’Media’ list of the Import dialog. 
Select the tape drive as the ‘Input device’. At LCC, the name is /dev/rmt/0mb. 
If this option is not available in the list, the drive needs to be added (see the 
instructions in Importing of FAST format in page 33).   

6. Give your image a name in the ’Output file’ box and click ‘OK’. 

7. The next dialog will prompt you for further information. The opening of the 
dialog might, however, take a while.  
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8. The popup window shows the information read from tape. Clicking ‘OK’ will do 
the rest of the job. 

Importing NLAPS format 

1. Put the right tape in the tape drive 

2. Start Erdas Imagine by typing Imagine in the UNIX terminal window. 

3. Click the button IMPORT on the Erdas Imagine taskbar. 

4. Select TM Landsat Generic Binary in the ’Type’ list of the Import dialog. 

5. Select the option tape in the ’Media’ list of the Import dialog. 
Select the tape drive as the ‘Input device’. At LCC, the name is /dev/rmt/0mb. 
If this option is not available in the list, the drive needs to be added (see the 
instructions in Importing of FAST format in page 33).   

6. Give an output name to your image and click OK.  

7. You are prompted with a dialog where data format, data type and image 
dimensions need to be filled. The opening of the dialog may take a while.  

 

8. Select ‘BSQ’ as the data format and make sure data type is ‘unsigned 8-bit’.  

9. Mark the check box ‘bands in multiple files’.  

10. Fill in the right amounts of rows, columns and bands. You can find these on the 
meta-data sheet for the images that have NLAPS format. 

11. Leave the amount of header bytes on zero. 

12. Click ’OK’ to start the import.  

35 



Appendix B) Working instructions 

Creation of folder system for WA-GIS image processing 
The image files created during the process were    

Folder Processing step Naming convention 

A_Original Copied here from CD before any 
processing.  

As is. 

B_Rectified Saved here during the 
rectification process. 

“TM” + New CD number +”_”+ 
original image code 
e.g. TM202r_56086.img 

C_Cleaned Saved here during the cleaning 
process. 

“TM” + CD number +”r_”+ original 
image code 
e.g.TM202_56086.img 
 

D_InfoLayer Saved here during the Info Layer 
creation. 

“TM” + CD number +”a_”+ original 
image code 
e.g.TM327_56086.img 

H_Mosaicfile Saved here after mosaicking.  

It is suggested that the actual processing tasks will be performed in the local computer 
disks due to the large file sizes. All data not yet stored to the CD ROMs should be 
placed to the local disk.  

 

Rectification of images

Cleaning the images 

Saving image to CD library and 
desctiption to database

Adding an info layer

Mosaicking step

Saving image to CD library and 
desctiption to database

New CD number

New CD number

Import and saving to CD
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Georeferencing of the imagery 
All the images are georeferenced to Geographical WGS8 coordinate system with 100 
meters pixel size. Scenes are georeferenced using JERS SAR mosaic as a reference. In 
the border zone of these two georeferencing methods, an effort is made to match the 
adjacent images as well as possible using both reference data sets. Each scene is 
georeferenced using 6 ground control points (GCPs)Rectification is done using first 
order polynomial and nearest neighbour resampling. 

The following describes step by step the rectification process. 

1. Open the image to one Imagine viewer and JERS mosaic to another viewer.  

2. It may help in the processing if you could see tile satellite image tiles on top of 
the JERS mosaic. For this, open the mosaic tiles in Shape format. 

3. Change the styles by selecting Vector > Viewing Properties. Change the polygon 
colour to transparent by clicking the color selection box and by selecting Other 
and uncheck the Use solid colour option.   

4. When in need for information about the path, row or CD Number, select the tile 
using the arrow tools and check the attributes by selecting Vector > Attributes. 
The selected scene is marked with yellow. 

5. Start rectification by selecting DataPrep > Image Geometric Correction.  

6. From Set Geocorrection Input File dialog, select From viewer > Select Viewer 
and click the image to be rectified.  

7. From Set Geometric Model dialog, select option Polynomial and click OK 

 

8. From Polynomial Model Properties dialog, select the Projection sheet and then 
Add/Change Projection. Define the projection to be Geographical, Datum 
WGS84 and Spheroid WGS84. First time, use the custom sheet for definition and 
save to projection settings with Save-button. Later, you can select this projection 
from Standard sheet. Click OK and return to Polynomial Model Properties dialog 
and click Close. 
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9. The GCP Tool Reference Setup dialog appears. Select the Existing Viewer option 
and click OK. Click the window containing the JERS mosaic and Click OK in the 
Reference Map Information dialog. The GCP tool and two chip viewers open. If 

the Fully Automatic GCP Editing is on, toggle it off.  

Use the Create GCP tool to pick GCP and its reference point from the two 
viewers one after another.  

10. Add altogether 6 control points to the image to places you can easily and reliably 
recognise from both images and which do not seem to change in the course of 
time (e.g. the centre of an oxbow lake, small islands, etc.). Select the GCPs as far 
apart from each other as possible.  

After adding at least 4 control points, use  button to calculate the RMSE. Try 
to keep the error smaller than 3 pixels. If needed, move the points using select tool 

 or delete an existing point by selecting its row and choosing Delete selection 
option from the Row Selection popup menu. 

11. After adding all control points, use File > Save Input As and File > Save 
Reference As options to save the GCP information to separate files. Name the 
files with  
Original CD Number + TM_input and Original CD Number + TM_ref 
(e.g.27TM_input.gcp) 

12. Start resampling from GeoCorrection tool’s Display Resample Image dialog 
button.  

38 



Appendix B) Working instructions 

 

13. In Resample dialog select output file name and location: Store image to 
B_Rectified folder with name  
New CD Number + “rTM_” + original image code, e.g. 202rTM_56086.img.  
Select Nearest Neighbour as resampling method and give output cell size (100 
meters) in meters by clicking Nominal button and entering the pixel size. Start 
resampling by clicking OK. 

 

14. Close the Geometric Correction tool by clicking Exit. Do not save the current 
geometric model.  
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Cleaning the scene 
After rectification the areas outside the actual image are cut off and the TM band 6 
(thermal band) is removed, leaving only 6 bands to the image. For cleaning the scene: 

1. Open the scene to a viewer. 

2. Open the Raster Toolbox (Hammer button in the top of the Viewer) and delineate 
the actual image area using Create Polygon AOI tool  .  

3. Select DataPrep > Create Subset Image. Define the input file to be the rectified 
scene, name for the output file, layers to be included and the Area of Interest 
(AOI) from the viewer. Save the output file to C_Cleaned folder with previous 
name as earlier but remove the character R after the CD number 
(TM202_56086.img). 
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Removal of the trend from the images 
The gradient was evened out for those images that most suffered from the 
phenomenon. The gradient removal was done in ArcInfo as explained in the 
following. However, as later experienced in Peru, the similar processing can be done 
also within Erdas Imagine.  

1. Dealineate areas of interest (AOI) from the image that contain supposedly 
similar forest. The calculation of the trend surface is later based on these 
images. Search for AOIs from different parts of the image, as far apart as 
possible.  

 
2. Save the AOIs to a file (File > Save > AOI Layer As). 
3. Subset the image with the AOI: Data Prep > Subset Image. Select the AOI 

using the AOI button.  
 
4. Export the resulting image to 

ArcInfo Grid format (Erdas 
Imagine > Import). In the 
Import/Export dialog box, select 
the Export option and fill in the 
boxes. Export the file to a folder 
of its own with a name IMAGEF 
(image file). 
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5. Start ArcInfo and run the script below. The ArcInfo macro that calculates the 
trend surface and provides the statistics for the aspect and strength of the trend. 
It would have been more elegant to build a loop within the macro, but with 
only 6 bands, it worked nicely even like this. 

 
temp_oL1 = select(imagef_l1, "value > 
0") 
kill imagef_l1 all 
temp500_L1 = resample(temp_oL1 , 0.01, 
cubic) 
kill temp_oL1 
temp_dot = gridpoint(temp500_L1, value) 
kill temp500_L1 
trend_L1 = trend(temp_dot, value, 1, 
linear, 0.01) 
kill temp_dot all 
temp_max = ZONALMAX(maskimg , trend_L1) 
sumimgl1 = (temp_max - trend_L1) 
kill temp_max 
asp_l1 = aspect(trend_l1) 
 
temp_oL2 = select(imagef_l2, "value > 
0") 
kill imagef_l2 all 
temp500_L2 = resample(temp_oL2 , 0.01, 
cubic) 
kill temp_oL2 
temp_dot = gridpoint(temp500_L2, value) 
kill temp500_L2 
trend_L2 = trend(temp_dot, value, 1, 
linear, 0.01) 
kill temp_dot all 
temp_max = ZONALMAX(maskimg , trend_L2) 
sumimgL2 = (temp_max - trend_L2) 
kill temp_max 
asp_l2 = aspect(trend_l2) 
 
temp_ol3 = select(imagef_l3, "value > 
0") 
kill imagef_l3 all 
temp500_l3 = resample(temp_ol3 , 0.01, 
cubic) 
kill temp_ol3 
temp_dot = gridpoint(temp500_l3, value) 
kill temp500_l3 
trend_l3 = trend(temp_dot, value, 1, 
linear, 0.01) 
kill temp_dot all 
temp_max = ZONALMAX(maskimg , trend_l3) 
sumimgl3 = (temp_max - trend_l3) 
kill temp_max 
asp_l3 = aspect(trend_l3) 
 
temp_oL4 = select(imagef_l4, "value > 
0") 
kill imagef_l4 all 
temp500_L4 = resample(temp_oL4 , 0.01, 
cubic) 
kill temp_oL4 
temp_dot = gridpoint(temp500_L4, value) 
kill temp500_L4 
trend_L4 = trend(temp_dot, value, 1, 
linear, 0.01) 
kill temp_dot all 
temp_max = ZONALMAX(maskimg , trend_L4) 
sumimgL4 = (temp_max - trend_L4) 
kill temp_max 
asp_l4 = aspect(trend_l4) 

 
temp_oL5 = select(imagef_l5, "value > 
0") 
kill imagef_l5 all 
temp500_L5 = resample(temp_oL5 , 0.01, 
cubic) 
kill temp_oL5 
temp_dot = gridpoint(temp500_L5, value) 
kill temp500_L5 
trend_L5 = trend(temp_dot, value, 1, 
linear, 0.01) 
kill temp_dot all 
temp_max = ZONALMAX(maskimg , trend_L5) 
sumimgL5 = (temp_max - trend_L5) 
kill temp_max 
asp_l5 = aspect(trend_l5) 
 
temp_oL6 = select(imagef_l6, "value > 
0") 
kill imagef_l6 all 
temp500_L6 = resample(temp_oL6 , 0.01, 
cubic) 
kill temp_oL6 
temp_dot = gridpoint(temp500_L6, value) 
kill temp500_L6 
trend_L6 = trend(temp_dot, value, 1, 
linear, 0.01) 
kill temp_dot all 
temp_max = ZONALMAX(maskimg , trend_L6) 
sumimgL6 = (temp_max - trend_L6) 
kill temp_max all 
kill maskimg all 
asp_l6 = aspect(trend_l6) 
 
&setvar imgnumb [response 'Enter a 
IMAGENUMBER'] 
&type imagenumber is %imgnumb% 
makestack tr_%imgnumb% list  trend_l1 
trend_l2 trend_l3 trend_l4 trend_l5 
trend_l6 
stackstats tr_%imgnumb% 
I:\arc\stats\trendd_%imgnumb%.txt 
detail 
stackstats tr_%imgnumb% 
I:\arc\stats\trend_%imgnumb%.txt  
makestack sum_%imgnumb% list  sumimgl1 
sumimgl2 sumimgl3 sumimgl4 sumimgl5 
sumimgl6 
stackstats sum_%imgnumb%  
I:\arc\stats\sumlistd_%imgnumb%.txt 
detail 
stackstats sum_%imgnumb%  
I:\arc\stats\sumlist_%imgnumb%.txt  
makestack asp_%imgnumb% list  asp_l1 
asp_l2 asp_l3 asp_l4 asp_l5 asp_l6 
stackstats asp_%imgnumb%  
I:\arc\stats\aspectsd_%imgnumb%.txt 
detail 
stackstats asp_%imgnumb%  
I:\arc\stats\aspects_%imgnumb%.txt 
q 
q 
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6. Import the stack SUMIMG to Erdas imagine and sum the stack with the 
original image using the Imagine modeler.  

 



 

Mosaicking the images  
1. Select Data Prep > Mosaic Images, Mosaic tool opens. 

2. Start adding images to be mosaicked with Edit > Add Images, Add Images for 
Mosaic dialog box opens. Start building the mosaic by selecting images files 
to be included. Newly added images will overlay the images added earlier, so 
start from the cloudiest ones and proceed to better quality images. Images can 
also be ordered later.  

  

3. After all images have been added to the mosaic tool, set or check the Image 
matching option and Overlap function from the Edit menu. For the WAGIS 
mosaic options No matching was used and original pixel values were taken to 
the mosaic. Intersection was done without a cutline with an Overlay function. 

  

4. Start the mosaicking by selecting Process > Run mosaic.  
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Appendix C) CD database structure 
This appendix presents the structure of the Amazon CD database. The structure of the 
three tables (see also Figure 3) is presented in the tables below.  

Table 7. Fields of the FILES table in the database. Symbol  indicates that the field is a primary key 
of the table, while  identifies fields that are used as links to small option tables.   

COLUMN NAME PROP. TYPE DESCRIPTION 

File ID  Counter Running number given to each item in the 
database.  

CD number • Number Number of the CD. 

File Name • Text Descriptive name of the entered item or 
actual file name. 

Data Group ID  Number Code indicating whether the item is an 
original Landsat image, a processed RS 
image, a text document etc. 

File Format ID  Number Code indicating the file format, e.g. Erdas 
Imagine file, ER Mapper file text file etc.  

Source Organization ID  Number Code for the organization that provided the 
file. 

Country ID  Number Code specifying the country or area the 
item covers. 

Place Name • Text Names of one or more places, rivers or 
lakes within the covered area. 

Notes • Memo Space for any additional notes.  

Table 7. Fields of the ORIGINAL LANDSAT IMAGES table in the database. Symbol  indicates that 
the field is a primary key of the table, while  identifies fields that are used as links to small option 
tables.   

COLUMN NAME PROP. TYPE DESCRIPTION 

File ID  Number Code linking this table to the Files table with a 
one-to-one relationship. 

Nothing Really • Counter Used for creating links between different pages. 
Of no importance for the database user. 

Sensor ID  Number Code specifying the Landsat sensor 

Path • Number Path of the scene in Landsat WRS system. 

Row • Number Row of the scene in Landsat WRS system. 

Acquisition Date • Date Acquisition date of the image.  

Metadata • Hyperlink Hypelink to a TXT file containing the original 
metadata.  

Quicklook • Hyperlink Hypelink to a JPEG file containing the quicklook 
of the image. 
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Table 8. Fields of the PROCESSED IMAGES table of the database. Symbol  indicates that the field 
is a primary key of the table, while  identifies fields that are used as links to small option tables.   

COLUMN NAME PROP. TYPE DESCRIPTION 

File ID  Number Code linking this table to the Files table with a 
one-to-one relationship. 

Nothing Really • Counter Used for creating links between different pages. 
Of no importance for the database user. 

Image Type ID  Number Code presenting the remotely sensed data type 
(e.g. Landsat TM, Landsat MSS, JERS-1 SAR, 
NOAA, AVHRR) 

Original Images  Text Number(s) of the original image(s) used in the 
scene. 

Pixel Size • Number Pixel size of the image in meters. 

Rectified • Boolean Yes/No selection indicating if the image has 
been rectified and georeferenced.  

Projection  Number Code indicating the projection used in 
georeferencing. 

Datum  Number Code indicating the datum used in 
georeferencing.  

Atmospheric Correction  Boolean Yes/No selection indicating if the image has 
been atmospherically corrected. 

Subset  Boolean Yes/No selection indicating if the image is a 
subset of the original. 

Mosaicking  Boolean Yes/No selection indicating if the scene is a 
mosaic of more than one original image. 

Other Processing Types  Text Description of applied processing types not 
specified in the database. 
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Appendix D) Notes on UTU-ART database pages 

Functionality in HTML 

The functionality of an MS Access database can be used through the Internet when 
‘Pages’ are used instead of ‘Forms’. In principle a Page is very similar to a Form, 
however, there are a few important differences: 

• A Page is written in HTML, a Form is written in Visual Basic. 
• A ‘Page’ is stored outside the database and only has links to it, while a ‘Form’ is 

stored within the database. 

Bound Combo Boxes (drop down list) in a Page 

Create a bound Combo Box as follows: 
• Add a Combo Box to the Page in the Design View, while the Wizard Button in 

the Toolbox window is switched on. 
• In the wizard select: I want the combo box to look up values in a table or query. 
• Select the source table or query 
• Select the field that is linked to the table your building a Page from 
• Go through the rest of the wizard and push Finish 
• Now select the combo box in the design view and open the properties window 
• At Data/ControlSource, select the field in which to open the external data 
• If you like you can change the field ‘ListDisplayField’ if you do not want the data 

from the linked field, but from another field in the external table/query to show. 

Now it should work. Change the view and try. 

Hyperlinked fields in a Page 

One of the ways to create a hyperlinked field to a stored file on a page is as follows: 
• In the table that contains the hyperlink data, create a text field with the relative 

paths to the data (e.g. Metadatasheets\UTU_95.txt). Paths are relative to the 
position of the database. 

• Create a Page of the table that contains your links and add a hyperlink to the 
page. 

• Under ‘Data’ in the hyperlink properties, set the option ControlSource to the field 
that holds the link. 

• Under ‘Anchor’ in the hyperlink properties, set the option ControlSource 
(Anchor) to the field that holds the link 

• Under ‘Anchor’ in the hyperlink properties, set the option Href so that it forms a 
prefix for the linked data (e.g. file:///D:/Albert/Amazon/database/) 

Thus, the two examples in above make a link to the following file:  
• file:///D:/Albert/Amazon/database/Metadatasheets\UTU_95.txt) 
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Specifying the characteristics of the window that opens when clicking a 
hyperlink 

When adding a hyperlink, Access does not give any standard properties to set the 
characteristics of the opening window (except for Target). You can set the 
characteristics in the Microsoft Script Editor. Follow the next steps: 

• Open you page in design view 
• Right click the hyperlink from which you want to edit the opening window 
• From the element properties, check the Id (from the All tab) 
• Open the Microsoft Script Editor 
• From Edit/Find search from the Id and look for the following string (note that in 

your case this string might be slightly different): 

<A href="Processing.html" id=ImageHyperlink1_Anchor   

target=parent><IMG id=ImageHyperlink1  

src="Original Data Entry_files\image009.jpg"  

style="BORDER-BOTTOM: 0px; BORDER-LEFT: 0px; BORDER-RIGHT: 0px; 
BORDER-TOP: 0px; HEIGHT: 0.608cm; LEFT: 15.001cm; POSITION: 
absolute; TOP: 0cm; WIDTH: 0.714cm; Z-INDEX: 1"  

tabIndex=35></IMG></A> 

• In this string you can add an On Click command. When doing so, the name of the 
file you refer to moves from straight after A href= to the On Click string. The on 
click string looks as follows (note the different window settings you can change) 

<a href="#" onClick="MyWindow=window.open('Processing.html 
','MyWindow','toolbar=no,location=no,directories=no,status=n
o,menubar=no,scrollbars=no,resizable=no,width=375,height=190
,left=20,top=20'); return false;"> 

• So, integrated in the script it looks as follows: 

<A href="#" id=ImageHyperlink1_Anchor   

target=parent onClick="MyWindow=window.open('Processing.html 
','MyWindow','toolbar=no,location=no,directories=no,status=no,menu
bar=no,scrollbars=no,resizable=no,width=375,height=190,left=20,top
=20'); return false;"><IMG id=ImageHyperlink1  

src="Original Data Entry_files\image009.jpg"  

style="BORDER-BOTTOM: 0px; BORDER-LEFT: 0px; BORDER-RIGHT: 
0px; BORDER-TOP: 0px; HEIGHT: 0.608cm; LEFT: 15.001cm; POSITION: 
absolute; TOP: 0cm; WIDTH: 0.714cm; Z-INDEX: 1"  

tabIndex=35></IMG></A> 

Adding alerts to a Page 

Instead of a normal hyperlink one can add an alert to a page, which means that after 
clicking a certain word or sentence a windows alert window opens (presented below) 
giving a certain message. 
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Add an alert as follows: 
• Open you page in design view 
• Open the Microsoft Script Editor (button in top menu bar) 
• Search for the string that contains the word or sentence you would like to add the 

link to. The string looks as more or less as follows (the word to link to is Path:): 

style="HEIGHT: 18px; LEFT: 159px; POSITION: absolute; TOP: 64px; 
WIDTH: 48px">Path:</SPAN> 

• Add an ‘On Click’ command as follows: 

style="HEIGHT: 18px; LEFT: 159px; POSITION: absolute; TOP: 64px; 
WIDTH: 48px"> 

<A onclick="alert('Enter the Worldwide Reference System (WRS) path 
number.')"><U>Path:</U></A></SPAN> 

 

• Save the file in the Micrsoft Script Editor 

Note 1: Replace the words between ('   ') to change the text in the alert. 

Note 2: the <U> </U> command does not belong to the on click command, but just 
underlines the word Path: 

Adding a Find button to a Page 

One can add a Find button to a page by following the steps below. The resulting Find 
button will query one field of your page for a specific string. 

• Open a data access page in Design view.  
• Make sure the Control Wizards tool in the toolbox is not selected. This turns off 

the wizard.  
• In the toolbox, click the Command Button tool.  
• On the data access page, click the command button in the header section that 

corresponds to the recordset that you want to search.  
• Click the Microsoft Script Editor button in the top menu bar. 
• On top of the editor’s main window there are two pull down lists. In the left one, 

select the button you added and in the right one, select On Click to go to the part 
of the text that describes what happens after clicking the button. 

• Edit the On Click script in the main window (see example below, it shows the 
script of a button that finds a specific Path) 

• Save your edits and close the Microsoft Script Editor. 
• Now you can change the looks of your button from the Command button 

properties. 
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Search for specific Path script (note that all the lines starting with (') are ruled out and 
do not influence the characteristics of the button): 
<SCRIPT language=vbscript event=onclick for=btnFind> 
<!-- 
' Clone the recordset. 
Dim rs 
Set rs = MSODSC.DataPages(0).Recordset.Clone 
 
On error resume next 
' This line assumes that the value you are filtering on is an integer. 
' If the search value is a string, use slightly different syntax. 
' For example, "CustomerID = '" & CStr(InputBox("Please enter customer to 
find", "Find")) & "'"  
rs.find "Path=" & cLng(inputbox("Enter a Path number","Find")) 
 
' Custom error handling. 
If (err.number <> 0) Then 
    Msgbox "Error: " & err.number & " " & err.description,,"Invalid Search" 
    Exit Sub 
End If 
 
' Check search results for success. 
If (rs.bof) or (rs.eof) Then 
    Msgbox "No Product found",,"Search Done" 
    Exit Sub 
End If 
 
MSODSC.DataPages(0).Recordset.Bookmark = rs.Bookmark 
--> 
</SCRIPT> 
 

Quickly create a reasonable looking page to start with 

You can very quickly create a reasonable looking page as follows: 
• In the database window, click the Pages tab 
• Push the New button 
• Select AutoPage: Columnar and define the source table or query from the 

dropdown list 
• Click OK 

Adding controls to a page 

Probably the easiest way to add data to a page is as follows: 
• Open or create a page in designview 
• Make sure the Field List is open (View/Field List) 
• Drag tables or table columns to the Page 

Creating a page (in Wagis database) that only shows records of one 
datatype, but includes information from the Files table 

When creating pages that show info from one data type, including info from the Files 
table, it is important to add the controls of that data type first and then add the controls 
of the Files table. In case you do it the other way around, the resulting page will show 
all records from the Files table, including those that do not belong to the data type you 
actually want to browse. 

Creating a tabular page with a row for each record 

If you want to create a tabular page with a new row for each record, 
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• Open or create a page in designview 
• Make sure the Field List is open (View/Field List) 
• Drag your table of interest to the page 
• In the wizard that appears, select tabular 

Creating a Page for data entry only 

When creating a standard page, one can enter data as well as browse through the 
different records. If you want a page that will only allow for data entry, follow the 
next steps: 

• Open the page in design view 
• Right click your mouse and select Page Properties 
• In the properties, select the Data Tab 
• Set DataEntry to through 

Create a non editable textbox 

You can set the properties of a textbox so that the data becomes non-editable. Just 
select the text control box in design view and change the Read Only option, under the 
Others tab of the properties, to true. 

Adding and removing buttons from the Page toolbar 

In order to add or remove buttons from the Page toolbar, do the following: 
• Open the page in design view and right click the toolbar 
• Go to Navigation Buttons and customize as you wish 

Creating a hyperlink that connects two pages 

You can create a hyperlink that connects two pages as follows: 
• Open the page to which you want to put the link in design view 
• From the toolbar, select Hyperlink 
• Click the page on the position where you want to add the link 
• In the wizard type the name of the link in Text to display 
• At Look in, browse to the Page you want to link to. 
• Click OK. 

Note, you can also make the link such that it filters the goal page so that you will only 
see the record related to the record in which you clicked the hyperlink. Set this filter 
as follows: 

• In design view, open the properties of the hyperlink 
• Select the Anchor tab 
• Fill an SQL statement in the ServerFilter box. 

Notes: The SQL statement links the one page to the other, so basically you have to tell 
which field in the one table equals which field in the second table. So far I could it 
only get working with number fields. For example like this: 

CDNumber=[CDNumber] 

51 



Appendix D) Notes on UTU-ART database pages 

In case you do not have fields you could use for linking, you could also add an 
autonumber to one of the table present in both pages and add it to both pages as a 
hidden control. This will create a unique link for each record. 

Specifying the connection between Pages and the Database (connection 
files). 

You can connect the pages and the database in two different ways, either by setting 
the connection information in each Page separately, or then by creating a connection 
file. The advantage of a connection file is that it sets the connection properties for 
several pages at once. So when you later move the Database, or the Pages, it is 
relatively easy to update the connections. Simply open the connection file in a text 
editor and change the Source information. 

You can create a connection file as follows: 
• If a database is open in Microsoft Access, close it.  
• On the File menu, click New.  
• In the New File dialog box, click Blank Data Access Page.  
• In the Select Data Source dialog box, click New Source.  
• In the Data Connection Wizard dialog box, select the data source that you want 

to connect to.  
• Follow the directions in the wizard dialog box.  
• Access creates a connection file with the information you specified.  
• In the Select Data Source dialog box, click Cancel.  
• Access creates a blank data access page.  
• Close the data access page.  
• You can use the connection file with existing or new data access pages.  

See the Access help files for more information. 
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Appendix E) Various Instructions for ArcIMS site modification 
Most of the information below was obtained from ESRI’s ArcIMS Forum. In case you have 
questions about ArcIMS, it’s a good idea to check these pages. 

• Adding images to services 
• Taking away the overview map 
• Changing letter size of the field names in the ‘Layers’ frame 
• Making links of the field names in the ‘Layers’ frame 
• Displaying a layer info button next to each layer name (info will be shown 

search result window). 
• Modification to aimsIdentify.js to correct hyperlinkprefix and hyperlinksuffix 

bug 
• Changing the appearance of the copyright text 
• Changing the appearance of the scale bar 
• Changing the rounding of the scale bar to more appropriate numbers 
• Getting rid of the table borders of the tool menu 
• Changing the standard tool bar button menu to one long vertical row 
• Defining the position of the toolbar buttons 
• Changing background color of the toolbar frame 
• Changing background color of the bottom frame 
• Changing background and text color of the mode frame 
• Setting the background color of the map frame 
• Rearranging the toolbar buttons in one horizontal line in the bottom frame 
• Rearranging the toolbar buttons in a horizontal line in the right of the top 

window 
• Changing sizes of the different frames 
• Taking off the frame borders 
• Setting characteristics of the overview map 
• Using external window for Identification Info 
• Using external window for Search and Query forms 
• Changing the colors of find, query and identify forms/windows: 
• Change zoomfactor 
• Replacing ArcIMS logo in top left with other logo and change link 
• Adding a folder like grouping system to the layer list 
 

Adding images to services 

ArcIMS recognizes different image formats (see also ArcIMS Help files, chapter 
‘Authoring Map Services/Data Formats for ArcIMS). Images can be used as a 
background. ArcIMS subsets the original image files and converts them into JPEG 
before sending them over the Internet. Because of this procedure the original images 
can be fairly large. 

 
World files 

In order to project the images in the correct coordinate space most image types need a 
world file (see also ArcIMS Help files). This file contains information about the cell 
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sizes and the coordinates of the top left pixel. World files are very easy to program 
yourself. A typical world file looks like this:  

 
0.0045 
0.0 
0.0 
-0.0045 
-82.06759695 
6.69 
 

Line one and four are cell sizes, line two and three probably represent the top left 
corner (though I’m not sure), line five and six are coordinates of the top left corner.  

It's easy to identify the world file that should accompany an image file: world files use 
the same name as the image, with a "w" appended. For example, the world file for the 
image file mytown.tiff would be called mytown.tiffw, and the world file for 
redlands.rlc would be redlands.rlcw. For workspaces that must adhere to the 8.3 
naming convention, the first and third characters of the image file's suffix and a final 
"w" are used for the world file suffix. Therefore, if mytown.tif were in an 8.3 format 
workspace, the world file would be mytown.tfw. If redlands.rlc was in an 8.3 format 
workspace, its world file would be redlands.rcw. 

 
Adding very large images (such as Landsat TM Mosaic) 

In order to add the Wagis mosaic to the Amazon Team Internet site, the original Erdas 
Imagine file was recalculated into three new Imagine files. One with a pixel size of 
1000m, one with pixel size 500m and one with a 250m pixel size. These three 
Imagine files were then exported to a RGB image in TIF format. World files were 
added as well. In the ArcIMS Author the different image files were then assigned to 
different zoom levels, so that with high scale factors broad pixels are shown and when 
zooming in, smaller pixels. 

This procedure has the following advantages: 
 
• When zooming out, ArcIMS uses a smaller file to calculate the JPEG image. 

This saves time. 
• When zooming out, the larger pixel sizes result is a less fuzzy and more clear 

image. 
 

Note: When the image files grow too big, the ArcIMS Author is not able to handle 
and project them anymore. It may then be necessary to add the largest images into the 
AXL file manually. Just open the file in a text editor and copy and adjust the string of 
the smaller images you could add using the Author. Once added to the AXL file, the 
images will show correctly on the Internet. When working in the Author afterwards, 
it’s better not to zoom in too much since the program may again get stuck trying to 
open the largest files (you can also find some info in the ArcIMS Help files on this 
topic. It’s in the chapter ‘Authoring Map Services/Data Formats for ArcIMS). 
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Taking away the overview map 

Taking off the Overview Map is very quick and easy, just follow the following steps: 

• In the ArcIMSparam file change line 32 to: var has OVMap = false 

• In the Mapframe.html change line 79 to: ovIsVisible = false 

Changing letter size of the field names in the ‘Layers’ frame 

You can change the letter size by filling a new value for ‘Size’ in line 164 of the 
toc.htm file. 

Making links of the field names in the ‘Layers’ frame 
In toc.htm: 

replace  
document.writeln('<td><font face="Arial" size="-1">' + 
t.LayerName[i] + '</font></td>');  

with  
if (t.hrefLayer[i]) {  
document.writeln('<td><a href=' + t.hrefLayer[i] + 
'target="_BLANK"><font face="Arial" size="-1">' + 
t.LayerName[i] + '</font></a></td>'); 
} else { 
document.writeln('<td><font face="Arial" size="-1">' + 
t.LayerName[i] + '</font></td>'); 
} 

note 
If you want the layer names to appear as a link, underline them 
by putting the tags <u></u> in the above string like this: 
if (t.hrefLayer[i]) { 
document.writeln('<td><a href=' + t.hrefLayer[i] + 
'target="_BLANK"><font face="Arial" size="-1"><u>' + 
t.LayerName[i] + '</u></font></a></td>'); 
} else { 
document.writeln('<td><font face="Arial" size="-1">' + 
t.LayerName[i] + '</font></td>'); 
} 

Furthermore, you can change letter size and color e.g. like this: 
if (t.hrefLayer[i]) { 
document.writeln('<td><a href=' + t.hrefLayer[i] + 
'target="_BLANK"><font face="Arial" size="-2" 
color="blue"><u>' + t.LayerName[i] + 
'</u></font></a></td>'); 
} else { 
document.writeln('<td><font face="Arial" size="-1">' + 
t.LayerName[i] + '</font></td>'); 
} 

In ArcIMSParam.js: 
add the following lines of code somewhere near the top of this file  
// href info for layers list in TOC 
var hrefLayer = new Array(); 
hrefLayer[0] = '"put url here"'; 
hrefLayer[1] = '"put url here"'; 
hrefLayer[2] = '"put url here"'; 
hrefLayer[3] = '"put url here"'; 
hrefLayer[4] = '"put url here"'; 
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Example: 
hrefLayer[5] = '"http://map1.ngdc.noaa.gov/index.html"'; 
NOTE: A common error is the single and double quotes are 
improperly placed. The format for the hreflayer line is single 
quote, double quote, url, double quote and single quote.  

In the above lines, substitute put url here with the metadata url that you want 
to reference. Fill out the array above with the url for each layer that you have 
in the TOC area. If a layer is turned off at the global level, the scale dependent 
layer needs to be a item in the array above.  
If you have six layers in the TOC area:  

The first layer corresponds to hrefLayer[0] 
The second layer corresponds to hrefLayer[1] 
The third layer corresponds to hrefLayer[2] 
The fourth layer corresponds to hrefLayer[3] 
The fifth layer corresponds to hrefLayer[4] 
The sixth layer corresponds to hrefLayer[5] 

When the end user clicks on the field name a separate window will 
appear with the associated metadata for that layer.  
 

Displaying a layer info button next to each layer name (info will be 
shown search result window). 
 
In the MapFrame.htm file, change the following string (line 78) to true: 
 
displayLayerInfoButton= false; 

 

Modification to aimsIdentify.js to correct hyperlinkprefix and 
hyperlinksuffix bug 

There seemed to be an error in the default code in the aimsIdentify.js file. You should 
make a correction to one line of code at line 256. Here is the corrected code: 
if (showHyper) { 

for (var s1=0;s1<hyperLinkFields.length;s1++) { 
if (hyperLinkFields[s1]==fName1[f]) { 

var theLinkURL = hyperLinkPrefix[s1] + fValue1[f] + 
hyperLinkSuffix[s1]; 
Win1.document.write('<a href="' + theLinkURL + '" target="_blank">'); 
isHyper=true; 
 

Changing the appearance of the copyright text 
Most of the settings can be changed in the lines 144-155 of the ArcIMSparam.js file. 
They look as follows: 
 
// Copyright blurb 
var drawCopyright = true; 
var CopyrightFont = "Arial"; 
var CopyrightStyle = "Bold"; 
var CopyrightSize = "8"; 
var CopyrightCoords = "4 4"; 
var CopyrightColor = "0,0,0"; 
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var CopyrightBackground = "False"; 
var CopyrightBGColor = "255,255,255"; 
var CopyrightGlow = "True"; 
var CopyrightGlowColor = "255,255,255"; 
var CopyrightText = "Map created with ArcIMS - Copyright (C) 1992-
2001 ESRI Inc."; 

 
However, if you want to get rid of the nasty shadow, you have to adjust the aimsXML 
file. Change line 736 from: 
 
theString += 'shadow="32,32,32" overlap="false" '; 

 
to: 
 
theString += 'shadow="false" overlap="false" '; 

 

Changing the appearance of the scale bar 
 
The style in which the scale bar appears can be set in the ArcIMSparam.js file. Just 
edit the ScaleBar parameters (somewhere around line 135). The parameters look as 
follows: 
 
var drawScaleBar = true; 
 // MapUnits=DEGREES,FEET,METERS 
 // can MapUnits be changed by user? 
var setMapUnits=false; 
 // ScaleBarUnits=KILOMETERS,METERS,MILES,FEET 
var ScaleBarBackground = "TRUE"; 
var ScaleBarBackColor = "0,0,0"; 
var ScaleBarFontColor = "255,255,255"; 
var ScaleBarColor = "192,192,192"; 
var ScaleBarFont = "Arial"; 
var ScaleBarStyle = "Bold"; 
var ScaleBarRound = "1"; 
var ScaleBarSize = "14"; 
var ScaleBarWidth = "7"; 
var ScaleBarPrecision = 2; 
var numDecimals = ScaleBarPrecision; 

 

Changing the rounding of the scale bar to more appropriate numbers 
 
In order to do this, two things should be done. Add the following script to the 
aimsXML.js file: 
 
theString += 'round="' + ScaleBarRound + '" ' 

 
You can put it at line 762, just above the string: 
 
if (MapUnits!="DEGREES") {  
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Then open the ArcIMSparam.js file and set the variable ScaleBarRound (probably in 
line 139). The number you fill stands for the amount of kilometres/meters/feet you 
round to. 
 

Getting rid of the table borders of the tool menu 
 
Open the toolbar.htm file and change in line 70: 
 
TABLE BORDER=”1” 

 
To 
 
TABLE BORDER=”0” 
 

Changing the standard tool bar button menu to one long vertical row  
(to create one horizontal row, please check “Rearranging the toolbar buttons in one 
horizontal line in the bottom frame”) 
 
In order to do this, two things should be done in the toolbar.htm file. First, from all the 
lines quoting: 
 
if (isSecond) document.write('</tr><tr>'); 
 
delete the part 
 
if (isSecond)  

 
Then, add the following line: 
 
document.write('</tr><tr>'); 

 
under (probably lines 82-86): 
 
// Legend toggle. . . requires aimsLegend.js 
document.write('<td align="center" valign="middle">'); 
document.write('<img src="images/togglelegend.gif" width=16 height=16 
hspace=1 vspace=0 border=0 alt=" ' + t.buttonList[14] + '" 
name="legend" 
onmousedown="parent.MapFrame.clickFunction(\'legend\');" 
onmouseover="window.status=\' ' + t.buttonList[14] + '\'">'); 
isSecond = !isSecond; 
document.writeln('</td>'); 

 

Defining the position of the toolbar buttons 
To some extent you can influence the position of the toolbar buttons by changing the 
settings in the following string of the toolbar.htm file (line 70): 

 
<TABLE BORDER="0" CELLSPACING="1" CELLPADDING="1" ALIGN="CENTER" 
VALIGN="MIDDLE" BGCOLOR="White" BORDERCOLOR="Gray" 
BORDERCOLORLIGHT="Silver" BORDERCOLORDARK="Black"> 
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Changing background color of the toolbar frame 
You can change the background color of the toolbar frame from the toolbar.html file 
by changing the definition of the following code (line 68): 
 
<BODY BGCOLOR="Silver" 
 

You can e.g. change “Silver” to “White” 
 

Changing background color of the bottom frame 

The background color of the bottom frame can be set in the bottom.htm file. From line 
7 you can delete the link to the image and change the BGCOLOR code. For example 
like this: 

<BODY BGCOLOR="#0033CC" LEFTMARGIN=0 TOPMARGIN=0> 

Changing background and text color of the mode frame 

The background and text color of the mode frame can be set in the ModeFrame.htm 
file. From line 7 you can change the background color by deleting the link to the 
image and change the BGCOLOR code. The TEXT tag defines the color of the link 
text. Edit the line for example like this: 

<BODY BGCOLOR="White" TEXT="#0033CC" LINK="Black" VLINK="Black" 
LEFTMARGIN=0 TOPMARGIN=0> 

Note: for some reason do changes to the ModeFrame.htm not always update with a 
normal refresh (Ctrl+F5) in the browser. You will probably have to close and reopen 
it. 

Setting the background color of the map frame 

You can set the background color of the map frame in the ArcIMSparam file. In order 
to do so, change the color code in the following line (25): 

 

var mapBackColor = '225,225,225'; 

Rearranging the toolbar buttons in one horizontal line in the bottom 
frame 

If you do not like the standard toolbar on the left side of the screen, you can move and 
rearrange the buttons in another frame, like the bottom frame for example. In order to 
do so, two things should be done. First one has to move the buttons to the bottom 
frame and second the buttons have to be rearranged into one horizontal row in order to 
fit the frame. 
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Moving the toolbar buttons to the bottom frame 

This is very easy and can be done in the viewer.htm file. Here the basic frames are 
defined. The script can be read as follows: Line 46 states that in the top of the screen 
there’s one row. This row is defined as the top frame in line 47. Then line 48 states 
that the second row consists of 3 columns. On the left the Toolframe, in the middle a 
frame set with the Mapframe and the Textframe and on the right the Tocframe. The 
rest of the frames is described below this. 

A very easy way to get the tools from the Toolframe to the Bottom frame is to just 
switch the frame names. In line 50, change (always use a text editor to change the 
viewer.htm frame file. Dreamweaver for some reason does not save changes 
correctly): 

<FRAME NAME="ToolFrame" 

To: 

<FRAME NAME="BottomFrame" 

And then in line 59, change: 

<FRAME NAME="BottomFrame" 

To: 

<FRAME NAME="ToolFrame" 

The first change makes that the bottom frame is projected at the place of the 
toolframe. By setting it’s width to 0 you can now prevent it from showing at all. To do 
so, change line 48 as follows: 

('<FRAMESET COLS="' + (50+addNS) 

To: 

('<FRAMESET COLS="' + (0+addNS) 

Note that it’s also possible to completely take out the original ToolFrame, however 
the solution above works as well. 

Showing the tools in one horizontal row 

If after making the changes above you reload the ArcIMS page, you’ll note that the 
toolbar moved to the bottom frame, but only one button shows because the others do 
not fit. You can make them fit by putting the buttons in one horizontal row. This can 
be done as follows: 

In the Toolbar.htm file, set the following quote (line 10) to false: 

var isSecond=true; 

Then command out all the lines that read: 

isSecond = !isSecond; 

Save the Toolbar.htm file. Now when you reload the IMS page, the toolbar should 
show correctly. 
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Rearranging the toolbar buttons in a horizontal line in the right of the top 
window 

If you do not like the standard toolbar on the left side of the screen, you can move and 
rearrange the buttons in another frame, like the top frame for example. In order to do 
so, two things should be done. First one has to move the buttons to the top frame and 
second the buttons have to be rearranged into one horizontal row in order to fit the 
frame. Rearranging the buttons into one horizontal row is explained in the paragraph 
“Rearranging the toolbar buttons in one horizontal line in the bottom frame”. Below 
will be explained how to move the toolbar to the right of the TopFrame 

In principle one has to adjust the viewer.htm file so that the top frame is subdivided in 
two columns. In the right of these two columns the toolbar will be placed. The 
subdivision is to be made directly under the following line (45): 

document.writeln('<FRAMESET ROWS="' + (30+addNS) + ',*,30,0" 
FRAMEBORDER="Yes" FRAMESPACING="0" onload="doIt()" BORDER=0 ' + 
moreStuff + '>'); 

Furthermore the old toolbar frame width is set to 0 by setting: 

('<FRAMESET COLS="' + (50+addNS) 

To: 

('<FRAMESET COLS="' + (0+addNS) 

Then in the old line defining the contents of the Toolbar frame, the Frame name, 
linking to the tool bar is removed: 

<FRAME NAME="" SRC="blank.htm" MARGINWIDTH="0" MARGINHEIGHT="0" 
SCROLLING="No" FRAMEBORDER="Yes" NORESIZE FRAMESPACING="0" 
BORDER="0"> 

However, have a look at it yourself. The frame definition below does the trick!!: 

document.writeln('<FRAMESET ROWS="' + (30+addNS) + ',*,30,0" 
FRAMEBORDER="Yes" FRAMESPACING="0" onload="doIt()" BORDER=0 ' + 
moreStuff + '>'); 

document.writeln('<FRAMESET COLS="*,600" FRAMEBORDER="No" 
FRAMESPACING="0" BORDER=0>'); 

document.writeln('<FRAME NAME="TopFrame" SRC="top.htm" 
MARGINWIDTH="5" MARGINHEIGHT="0" SCROLLING="No" FRAMEBORDER="0" 
NORESIZE>'); 

document.writeln('<FRAME NAME="ToolFrame" SRC="blank.htm" 
MARGINWIDTH="5" MARGINHEIGHT="0" SCROLLING="No" FRAMEBORDER="0" 
NORESIZE>'); 

document.writeln('</FRAMESET>'); 

document.writeln('<FRAMESET COLS="' + (0+addNS) + ',*,180" 
FRAMEBORDER="Yes" FRAMESPACING="0" BORDER=0>'); 

</SCRIPT> 

<FRAME NAME="" SRC="blank.htm" MARGINWIDTH="0" MARGINHEIGHT="0" 
SCROLLING="No" FRAMEBORDER="Yes" NORESIZE FRAMESPACING="0" 
BORDER="0"> 
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<FRAMESET ROWS="*,0">  

<FRAME NAME="MapFrame" SRC="MapFrame.htm" MARGINWIDTH="0" 
MARGINHEIGHT="0" SCROLLING="No" FRAMEBORDER="Yes" RESIZE="YES"> 

<FRAME NAME="TextFrame" SRC="text.htm" MARGINWIDTH="0" 
MARGINHEIGHT="0" SCROLLING="Auto" FRAMEBORDER="Yes" RESIZE="YES"> 

</FRAMESET>  

<FRAME NAME="TOCFrame" SRC="TOCFrame.htm" MARGINWIDTH="0" 
MARGINHEIGHT="0" SCROLLING="Auto" FRAMEBORDER="Yes" RESIZE="YES"> 

<FRAMESET COLS="180,*" FRAMEBORDER="0" BORDER=0 FRAMESPACING="0"> 

<FRAME NAME="ModeFrame" SRC="bottom.htm" MARGINWIDTH="0" 
MARGINHEIGHT="0" SCROLLING="No" FRAMEBORDER="Yes" NORESIZE> 

<FRAME NAME="BottomFrame" SRC="bottom.htm" MARGINWIDTH="0" 
MARGINHEIGHT="0" SCROLLING="No" FRAMEBORDER="Yes" NORESIZE> 

</FRAMESET> 

<FRAME NAME="PostFrame" SRC="jsForm.htm" MARGINWIDTH="0" 
MARGINHEIGHT="0" SCROLLING="No" FRAMEBORDER="Yes" NORESIZE 
FRAMESPACING="0" BORDER="0"> 

 

<NOFRAMES> 

Note 1: as already mentioned above, after redirecting the tools to the top right of the 
screen, the tools should be put in one horizontal line in order to fit the frame 

Note 2: In order to make the top bar look better, change the title color and background 
of the left part in the Top.htm file. You can edit the following line (22): 

<BODY BGCOLOR="Silver" LEFTMARGIN=0 TOPMARGIN=0 TEXT="#000099" 
BACKGROUND="images/grad_gray.jpg"> 

It is for example possible to just delete the Background command containing the 
image and set the Background color (BGCOLOR) to White. 

Note 3: If you don’t want the new tool frame to load the grey background color at 
first, set the BGCOLOR in Blank.htm to e.g. White 

Note 4: If you want to further organize the buttons, please read the paragraph 
“Defining the position of the Toolbar Buttons” 

Changing sizes of the different frames 

Some frame size settings can be changes in the viewer.html file. When doing this it’s 
probably best to open the file in Notepad and not in Dreamweaver. When saving the 
frames file in Dreamweaver something goes wrong and the site does not work 
anymore. Examples of changes you can make: 

• Adjust the toolbar frame. Make it e.g. narrower by changing: 

('<FRAMESET COLS="' + (50+addNS) 

To e.g.: 
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('<FRAMESET COLS="' + (30+addNS) 

• Adjust the text frame (under map). Make it e.g. narrower by changing: 

<FRAMESET ROWS="*,110"> 

To e.g.: 

<FRAMESET ROWS="*,70"> 

• Adjust the layers frame from: 

<FRAMESET COLS="' + (50+addNS) + ',*,180" 

• The top frame from: 

('<FRAMESET ROWS="' + (16+addNS 

• The bottom and mode frame from: 

('<FRAMESET ROWS="' + (30+addNS) + ',*,30,0 

Taking off the frame borders 

You can take away the frame borders from the overall page by changing all 
frameborder strings in the viewer.html to “No”. Thus: 

FRAMEBORDER="Yes" 

becomes: 

FRAMEBORDER="No" 

It’s best to do this in Notepad since Dreamweaver seems to alter the frames document 
so that it doesn’t work anymore. 

Setting characteristics of the overview map 
Contents 

The easiest way to define the contents of the overview map is to use the ‘Overview 
contents option’ given in the Designer when publishing your map. Here you are able 
to specify which map service to use. If needed you can create a special service, just 
for the overview map. 

Setting the size of the overview map 

The size of the overview map is calculated from the size of the map window by codes 
given in the MapFrame.html file. In order to change the size of the overview map you 
only have to change the ratio parameter in the following line (108): 

var locHeight = parseInt(mHeight/5); 

In order to get the overview map smaller, change the 5 to a lager number. In order to 
make it bigger, decrease the number. 
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Using external window for Identification Info 

In order to get information obtained from e.g. the Identification tool into an external 
window instead of the bottom info window, switch the following option in the 
ArcIMSparam.js file to true: 

var useExternalWindow=false; 

Using external window for Search and Query forms 

In order to open the search and query options in external windows instead of in the 
information window in the bottom of the screen one can set the following option in 
the ArcIMSparam.js file (line 209: 

var useTextFrame=true; 

You should change the value to false 

Note 1, windows on top: When switching off the TextFrame, some of the external 
form windows open under the map because the Window Focus is not correct. You can 
make all form windows open on top of the map window by following the next steps: 

• Open the Toolbar.htm file in a text editor or Dreamweaver and go to line 228, just 
below the “if (parent.MapFrame.useQuery) {“ statement. Reverse the order of 
functions called by the onmousedown event so that the setToolPic function is 
called prior to the clickFunction:  
 
if (parent.MapFrame.useQuery) {  
// Query . . . requires aimsQuery.js  
// IE 5.0 has big problems with the query stuff  
document.write('<td align="center" valign="middle">');  
document.write('<img src="images/query_1.gif" width=16 height=16 
hspace=1 vspace=1 border=0 alt=" ' + t.buttonList[28] + '" 
onmousedown="setToolPic(\'ClearOut\'); 
parent.MapFrame.clickFunction(\'query\');" 
onmouseover="window.status=\' ' + t.buttonList[28] + '\'">');  
isSecond = !isSecond  
document.writeln('</td>'); 
 
document.write('</tr><tr>');}  
 

• Go to line 246, just below the “if (parent.MapFrame.useFind) {“ 
statement. Switch the order called by the onmousedown event so 
that the setToolPic function is called prior to the click 
Function. For example.  
 

if (parent.MapFrame.useFind) {  
// Find . . . requires aimsQuery.js  
document.write(' <td align="center" valign="middle">');  
document.write('<img src="images/find_1.gif" width=16 height=16 
hspace=1 vspace=1 border=0 alt=" ' + t.buttonList[30] + '" 
onmousedown="setToolPic(\'ClearOut\'); 
parent.MapFrame.clickFunction(\'find\');" 
onmouseover="window.status=\' ' + t.buttonList[30] + '\'">');  
isSecond = !isSecond  
document.writeln('</td>'); 
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document.write('</tr><tr>');}  
 
}  

• In order to make the buffer tool open on top of the map, change line 296 of the 
Toolbar.htm file as described above. 

• Save the toolbar.htm file. 

Note 2, no Active Layer message in external window: Once you’ve switched off the 
TextFrame, ArcIMS starts opening a window when changing the active layer. The 
window shows the name of the active layer. You can switch this functionality off by 
deleting the lines 72-89 from the aimsLayers.js file. However, it should be mentioned 
that I’m not yet a 100% sure this does not negatively influence any other 
functionality. The exact text to delete is the following: 
 
if (queryOpen) { 
queryForm(); 
} else { 
if ((useExternalWindow) || (!useTextFrame)) { 
Win1 = 
window.open("","QueryWindow","width=575,height=120,scrollbars=yes,res
izable=yes"); 
theFrame = "opener"; 
if (parent.MapFrame!=null) theFrame = "opener.parent.MapFrame"; 
} else { 
Win1 = parent.TextFrame; 
Win1.document.open(); 
} 
Win1.document.open(); 
Win1.document.writeln('<html><meta http-equiv="Content-Type" 
content="text/html; charset=' + charSet + '"><head><title>' + 
titleList[1] + '</title></head>'); 
Win1.document.writeln('<body bgcolor="' + tableBackColor + '" 
text="Black" link="Blue" vlink="Gray" LEFTMARGIN=0 
onload="window.focus()">'); 
Win1.document.writeln('<center><FONT FACE="Arial" SIZE="-1"><b>' + 
LayerName[ActiveLayerIndex] + msgList[20] + '</b>'); 
Win1.document.writeln('</font></center></body></html>'); 
Win1.document.close(); 
} 

After deleting, save the aimsLayers.js file. 
 

Changing the colors of find, query and identify forms/windows: 
Find form colors 

Open the .htm file representing the form, e.g. findForm. Search for color tags, like 
those in line 34 and 38. Change the color, preferably using color names (e.g. Blue, 
White) of #…. Notations (e.g. #000099). 

An example of a script turning the background color of the findForm to bright blue is 
as follows: 
<BODY BGCOLOR="#0033CC" TEXT="White" TOPMARGIN=0 LEFTMARGIN=0> 
 <DIV ALIGN="center"> 
  <FONT FACE="Arial" SIZE="-2"><B> 

65 



Appendix E) Various Instructions for ArcIMS site modification 

  <FORM ACTION="" NAME="theFindForm" onsubmit="setStyle(); 
return false;"> 
   <TABLE CELLSPACING="2" NOWRAP BGCOLOR="#0033CC" 
WIDTH=100%> 
Query form colors 

Changing the query form colors is a bit different from changing the colors of the Find 
form. In this case the color parameters are set in the aimsQuery.js file. Basically one 
should replace all 

' + textFrameBackColor + '  

color statements in the lines 430-520. You van change the colors of the texts: Field, 
Operator and Value by adding color parameters to the following lines (about 440): 

Win1.document.writeln(' <tr><td align="CENTER" 
bgcolor="#0033CC"><font face="Arial" size="-2" Color="White">' + 
msgList[72] + '</font></td>'); 

Win1.document.writeln(' <td align="CENTER" bgcolor="#0033CC"><font 
face="Arial" size="-2" Color="White">' + msgList[73] + 
'</font></td>'); 

Win1.document.writeln(' <td align="CENTER" bgcolor="#0033CC"><font 
face="Arial" size="-2" Color="White">' + valueTitle + 
'</font></td>'); 

Identify result window colors 

Colors of the Identify result window can be set in the ArcIMSparam.js file, lines 213-
218. The strings that are to be set look as follows: 
 
// colors for tables  
var textFrameBackColor="#0033CC"; 
var tableBackColor="White"; 
var textFrameTextColor="Black"; 
var textFrameLinkColor="Blue"; 
var textFrameFormColor="Gray"; 
 

However, the color of the Layer name in the Identify window should be set from the 
aimsIdentify.js file (about line 175). Here you can add a color statement as follows: 

Win1.document.writeln('<FONT FACE="Arial" SIZE="-1" 
Color="White"><b>' + LayerName[ActiveLayerIndex] + '</b></FONT>'); 

 

Alert form colors (alert form shows when there are no object available for 
identification) 

The color characteristics of the Alert form can be set in the aimsIdentify.js file (about 
line 355-360). In the following example the background color was changed to blue 
and the text to white: 
Win1.document.writeln(' <title>' + titleList[8] + '</title>'); 

Win1.document.writeln('</head>'); 

Win1.document.writeln('<body BGCOLOR="#0033CC" TEXT="White" 
LEFTMARGIN=0 TOPMARGIN=0>'); 
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Win1.document.writeln('<FONT FACE="Arial"><B>' + 
LayerName[ActiveLayerIndex] +'</B></font><FONT FACE="Arial" size="-
2">'); 

 

Set units form color 

Colors of the set units form can be set in the setUnits.htm file. Background and text 
colors in the lines 145: 

<BODY BGCOLOR="#0033CC" TEXT="White" TOPMARGIN=0 
onload="window.focus(); setValues();" LEFTMARGIN=0> 

More background color in line 166: 

document.writeln('<TABLE CELLSPACING="2" NOWRAP BGCOLOR="#0033CC" 
WIDTH=100%>'); 

 

Set measure layer color 

Characteristics for the Measure layer are set in the MapFram.htm file. You can change 
them in the following line (195-198): 

// measure display 

content = '<form><table bgcolor="#0033CC"><tr><td><font face="Arial" 
size="-2" color="White"><b>Total:</b><INPUT TYPE="text" 
NAME="theMeasTotal" VALUE="0" SIZE="25"></td>'; 

content = content + '<td><font face="Arial" size="-2" color="White" 
><b>Segment:</b><INPUT TYPE="text" NAME="theMeasSegment" VALUE="0" 
SIZE="25"></td></tr></table></form>'; 

createLayer("measureBox",0,0,500,25,false,content); 

Use ‘bgcolor’ and ‘color’ to set background and text colors. Note that if you want to 
change the texts to white, one color strin should be added behind size=”-2” in line 
197. 

 

Set Buffer form color 

In order to set the background color of the Buffer form the Buffer.js file should be 
changed.. In the shapeBuffer.htm, adjust the ‘bgcolor’ variables in the following 
string. Replace the following quote in line 69: 

' + textFrameBackColor + ' 

with a color notation, e.g #0033CC in order to change to Blue. 

 

Set Selection by line/poligon form color 

Colors in this form can be set in the Select.htm file by changing the color statements 
in the lines 60-64. In the following example the color was set to blue: 
<BODY BGCOLOR="#0033CC" TEXT="White" TOPMARGIN=0 LEFTMARGIN=0 
onload="window.focus()"> 

67 



Appendix E) Various Instructions for ArcIMS site modification 

<DIV ALIGN="center"> 
<FONT FACE="Arial" SIZE="-2"><B> 
<FORM NAME="Measure"> 
<TABLE WIDTH="100%" CELLSPACING="2" NOWRAP BGCOLOR="#0033CC"> 

 
Set Print form color 

Colors in this form can be set in the Printform.htm file by changing the color 
statements in line 39. In the following example the background color was set to blue 
and the text to white: 

<BODY BGCOLOR="#0033CC" TEXT="White"> 

 

Find form size and position 

When opened in a separate window, the size and position of the find form can be 
changed in the aimsQuery.js file. The variables are stored in lines 48-59. They look as 
follows: 
// find Form 
function findForm() { 
if (checkIfActiveLayerAvailable()) { 
setLayerFields(ActiveLayerIndex); 
 
if (useTextFrame) { 
parent.TextFrame.document.location= appDir + "findForm.htm"; 
} else { 
var Win1 = 
open("findForm.htm","QueryWindow","width=575,height=120,left=200,top=
92,scrollbars=yes,resizable=yes"); 
} 
} 
} 

Just change the width,height,left,top parameters. Furthermore you can give in whether 
the window should have scroll bars, location and resizability options. 

 

Query form size and position (if separate) 

You can make changes to the parameters in the ‘open string’ of the following lines in 
the aimsQuery.js file ( around line 300): 
 
if (useTextFrame) { 
var Win1 = parent.TextFrame; 
Win1.document.open(); 
var t = "parent.MapFrame"; 
 
} else { 
var Win1 = 
open("","QueryWindow","width=575,height=130,left=200,top=92,scrollbar
s=yes,resizable=yes"); 
var t = "opener"; 
if (parent.MapFrame!=null) t = "opener.parent.MapFrame"; 
} 
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In the standard code the parameters ‘left’ and ‘top’ are not included. You can add 
them yourself. 

 

Identify result window size and position 

Edit the parameters in the following string (about line 164) of the aimsIdentify.js file: 
if (showSelectedData) { 
//alert("displayAttributeData()[opening html page]"); 
if ((useExternalWindow) || (!useTextFrame)) { 
Win1 = 
window.open("","QueryWindow","width=575,height=120,left=200,top=92,sc
rollbars=yes,resizable=yes"); 
theFrame = "opener"; 

In order to define the position, the parameters ‘left’ and ‘top’ were added. 

Note: in case no objects are identified ArcIMS doesn’t open an identify window, but 
an alert window instead. See Alert window notes for more information. 

 

Alert window size and position (shows when no objects are available for identification) 

The alert window size and position, together with some other window parameters, can 
be set in the aimsIdentify.js file (about line 350). The string looks like this (after 
editing pop up position): 
//alert(tempString); 
if ((useExternalWindow) || (!useTextFrame)) { 
Win1 = 
window.open("","QueryWindow","width=575,height=120,left=200,top=92,sc
rollbars=yes,resizable=yes"); 
} else { 

 
SetUnits form size and position 

In case the setUnits form opens in a separate window, window properties can be set 
from the aimsClick.js file, lines 345-350: 

case "setunits": 

if (useTextFrame) { 

parent.TextFrame.location = "setUnits.htm"; 

} else { 

window.open((appDir + 
"setUnits.htm"),"OptionWindow","width=575,height=120,left=200,top=92,
scrollbars=yes,resizable=yes"); 

} 

Set Measure layer size and position 

Size and position of the Measure Layer can be changed in the MapFrame.htm file, 
line 198. In the following example the position is shifted 200 pixels to the right. 

createLayer("measureBox",200,0,500,25,false,content); 
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Set Buffer form size and position 

In case the buffer form opens in a separate window, the window size and position can 
be set in the aimsBuffer.js file. In order to do so, one should adjust line 36. In the 
following example both window position and size were changed: 

} else { 

var Win1 = open(appDir + 
"text.htm","QueryWindow","width=575,height=120,left=200,top=92,scroll
bars=yes,resizable=yes"); 

Set Select by line/polygon form size and position 

In case this form opens a separate window, the window size and position can be set in 
the aimsClick.js file. In order to do so, one should adjust line 491. In the following 
example both window position and size were changed: 

Win1 = 
open("select.htm","QueryWindow","width=575,height=120,left=200,top=92
,scrollbars=yes,resizable=yes"); 

Set Print form size and position 

In case this form opens a separate window, the window size and position can be set in 
the aimsPrint.js file. In order to do so, one should adjust line 34. In the following 
example both window position and size were changed: 

if (useTextFrame) { 

parent.TextFrame.document.location = "printform.htm"; 

} else { 

var Win1 = 
open("printform.htm","PrintFormWindow","width=575,height=200,left=200
,top=92,scrollbars=yes,resizable=yes"); 

} 

Change zoomfactor 

The zoomfactor can be set in the ArcIMSparam.js file. Just change the value in the 
following string (line 105): 

var zoomFactor = 2 

Note that the zoom will not work at all when you put the zoom factor to 1. 

Replacing ArcIMS logo in top left with other logo and change link 

The ArcIMS logo in the top left of the screen can be replaced with another logo (e.g. 
that of the university) and one can alter the link to show the universities pages. 

 

Changing logo 

Changing the logo is very simple. Just replace the ArcIMS logo in the Image folder. 
The file to replace is called: aimslogo1x2 
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Changing link 

The link can be changed in the top.htm file, lines 12-17. One can for example replace: 
function showInfo() { 
if (parent.TextFrame!=null) { 
parent.TextFrame.document.location="arcimsInfo.htm"; 
} else { 
var Win1 = 
open("arcimsInfo.htm","InfoWindow","width=575,height=150,scrollbars=y
es,resizable=yes"); 
} 
} 

With: 

function showInfo() { 

var Win1 = 
open("http://www.utu.fi","InfoWindow","width=700,height=700,scrollbar
s=yes,resizable=yes"); 

} 

Adding a folder like grouping system to the layer list 

It is possible to add a grouping system to the layer list. Though it is rather though to 
program it yourself, ESRI provides you the code for free. It works very easy and can 
be downloaded from: 

http://caromap.esri.com/Website/BB/ScriptsTips/CARO_ArcIMS_Scripts.htm 

Just unzip the file and read the readme file. You can add the functionality to an 
already existing service. It will not take more than half an hour work (if you at least 
do not have an incredible amount of layers). 

However, installing this takes the old functionality of the Active Layer toggle box 
away, which is nasty when you want to use the layer names as links to metadata. 
Hope I can figure it out. 

Using folders in combination with the standard Active Layer toggle boxes 

The method above changes the system of selecting the active layer, if you want to use 
the old system with the toggle boxes you have to make changes to the ‘toc.html’ file. 

Delete the lines 263 – 271: 
 
document.writeln('<A href="JAVASCRIPT:setActiveLayer(' + iLyrFound + 
')" name="LayerLink' + iLyrFound + '" '); 
document.write('onmouseover="window.status=\'Set active layer to ' + 
t.LayerName[iLyrFound] + '\';return true"'); 
document.write('onmouseout="window.status=\'\'" target="_self"'); 
if (iLyrFound==t.ActiveLayerIndex) { 
document.write('style="background-color: cyan"'); 
} else { 
document.write('style="background-color: white"'); 
} 
document.writeln('>'); 
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And replace it with: 

document.write('<input type="Radio" onclick="setActiveLayer(' + 
iLyrFound + ')" name="Active"'); 

if (t.ActiveLayerIndex==i) document.write(' checked'); 
document.write('>'); 

Then delete line 289 – 297: 
document.write('<A href="JAVASCRIPT:setActiveLayer(' + i + ')" 
name="LayerLink' + i + '" '); 
document.write('onmouseover="window.status=\'Set active layer to ' + 
t.LayerName[i] + '\';return true"'); 
document.write('onmouseout="window.status=\'\'" target="_self"'); 
if (i==t.ActiveLayerIndex) { 
document.write('style="background-color: cyan"'); 
} else { 
document.write('style="background-color: white"'); 
} 
document.writeln('>'); 

And replace it with: 
document.write('<input type="Radio" onclick="setActiveLayer(' + i + 
')" name="Active"'); 
if (t.ActiveLayerIndex==i) document.write(' checked'); 
document.write('>'); 

 

This should do the trick. 

Including user info to the layers frame 

When adding the active layer radio button option to the folder system the column 
headings ‘Visible’ and ‘Active’ will not show. It seemed to be troublesome to add 
them so that they show properly. In order to solve this problem some user info can be 
added to the layers frame. You can for example add a table, with invisible borders, 
just under the word LAYERS. Here is an example: 

About line 195, in between: 
<SCRIPT LANGUAGE="JavaScript1.2"> 
<!-- 
TocWriteFixedWidth(false,400); 
TocInitPage(); 
//--> 
</SCRIPT> 

And: 
 
<TABLE CELLSPACING="0" CELLPADDING="1" NOWRAP> 
<!-- <TR> 
 
Add a table like this: 
 
<table width="173" border="0" cellspacing="1" cellpadding="1"> 
<tr>  
<td width="30"> <font face="Arial" size="-2">Check</font></td> 
<td width="25">  
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<div align="center"><font face="Arial" size="-1"><img 
src="images/Visible.jpg" width="17" height="16"></font></div> 
</td> 
<td width="108"><font face="Arial" size="-1"> <font size="-2">to set 
layer  
visibility</font></font></td> 
</tr> 
<tr>  
<td width="30"> <font face="Arial" size="-2">Check</font><font 
face="Arial" size="-1">  
</font></td> 
<td width="25">  
<div align="center"><img src="images/Active.jpg" width="13" 
height="13"></div> 
</td> 
<td width="108"><font face="Arial" size="-2">to set active 
layer</font></td> 
</tr> 
</table> 

 

Making hyperlinks of the layer names when using the folder system (with active layer 
toggle boxes). 

First, in the Toc.html file: 

Replace the following strings (about line 270): 
document.writeln('&nbsp;' + arrLyrs[k] + '</A></NOBR></P>'); 
} else { 
document.writeln('&nbsp;' + arrLyrs[k] + '</NOBR></P>'); 
} 

With: 
} 
document.writeln('<a href=' + t.hrefLayer[iLyrFound] + 
'target="_BLANK"><font face="Arial" color="#0033CC" size="-2"><u>' + 
t.LayerName[iLyrFound] + '</u></font></a>'); 

 

Then replace the following strings (about line 298): 
document.writeln('<font face="Arial" size="-1">' + t.LayerName[i] + 
'</font></span></A></td></tr>'); 
} else { 
document.writeln('<font face="Arial" size="-1">' + t.LayerName[i] + 
'</font></td></tr>'); 

With: 
document.writeln('<a href=' + t.hrefLayer[i] + 'target="_BLANK"><font 
face="Arial" color="#0033CC" size="-2"><u>' + t.LayerName[i] + 
'</u></font></a></span></A></td></tr>'); 
} else { 
document.writeln('<a href=' + t.hrefLayer[i] + 'target="_BLANK"><font 
face="Arial" color="#0033CC" size="-2"><u>' + t.LayerName[i] + 
'</u></font></a></td></tr>'); 

 

Note that the <a href= statements contain size, color and underline information with 
which you can change the looks of the layer names. 
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Second, in the ArcIMSParam.js file 

add the following lines of code somewhere near the top of this file  
// href info for layers list in TOC 
var hrefLayer = new Array(); 
hrefLayer[0] = '"put url here"'; 
hrefLayer[1] = '"put url here"'; 
hrefLayer[2] = '"put url here"'; 
hrefLayer[3] = '"put url here"'; 
hrefLayer[4] = '"put url here"'; 

Example: hrefLayer[5] = 
'"http://map1.ngdc.noaa.gov/index.html"'; 

NOTE: A common error is the single and double quotes are 
improperly placed. The format for the hreflayer line is 
single quote, double quote, url, double quote and single 
quote.  

In the above lines, substitute put url here with the metadata url that you want to 
reference. Fill out the array above with the url for each layer that you have in the TOC 
area. If a layer is turned off at the global level, the scale dependent layer needs to be a 
item in the array above.  

If you have six layers in the TOC area:  

The first layer corresponds to hrefLayer[0] 
The second layer corresponds to hrefLayer[1] 
The third layer corresponds to hrefLayer[2] 
The fourth layer corresponds to hrefLayer[3] 
The fifth layer corresponds to hrefLayer[4] 
The sixth layer corresponds to hrefLayer[5] 

When the end user clicks on the field name a separate window will appear with the 
associated metadata for that layer.  
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